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Abstract

Passive Coherent Location (PCL) radar has proved to be feasible in a num-
ber of experimental systems, but the lack of comprehensive, published flight
trials detracts somewhat from serious consideration of these PCL systems for
operational applications, such as Air Traffic Control (ATC). The carrying out

of flight trials is, in any case, difficult and very expensive.

This dissertation presents a method for accurately predicting the performance
of a bistatic passive coherent location radar with the effects of the environ-
ment taken into account. The effect of the environement on a propagating
electromagnetic wave is obtained from the Advanced Refractive Effects Pre-
diction System (AREPS) model. The resulting performance predictions, in the
form of spatial signal-to-noise ratio (SNR), signal-to-interference ratio (SIR)
and signal-to-noise-plus-interference ratio (SNIR) maps, provide a powerful
planning tool for the application of systems such as ATC. Furthermore, the
spatial coverage maps, based on the bistatic radar equation, can be related to
a particular probability of detection and false alarm as well as to a required
dynamic range of the receiver ADC. Overall, the method provides a visual, as
well as a quantitative measure of radar coverage with region-specific atmo-
spheric and terrain effects taken into account.

The method proposed in this dissertation offers a marked improvement over
traditional performance prediction methods based on the bistatic radar equa-

tion within a free space or flat terrain environment.

It is understood that the direct path signal of the illuminating transmitter is
the cause of some severe limitations within a PCL system. In the interest of
suppressing the strong direct signal before the ADC and to complement the
development of the prediction method, an antenna pattern was synthesised
and applied to an array of folded dipoles in order to place a null in the di-
rection of the strong transmitter. The synthesised antenna pattern and its
improvement on the performance of the PCL system was then evaluated us-

ing the proposed prediction method presented in this dissertation.
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Chapter 1
Introduction

This dissertation presents a method for accurately predicting the performance
of a bistatic passive coherent location (PCL) radar with the effects of the en-
vironment taken into account. The performance predictions, in the form of
spatial coverage maps, provide a visual and quantitative means for deter-
mining radar detection range and required receiver dynamic range within a
particular environment. These predictions in the form signal-to-noise and
signal-to-interference maps are derived from bistatic radar range equation.
The method proposed in this dissertation offers a marked improvement over
traditional performance prediction methods based on the bistatic radar equa-
tion within a free space or flat terrain environment. Furthermore, methods
of improving the performance of a PCL system via antenna pattern synthesis
techniques are investigated.

This chapter will begin with a brief yet comprehensive overview of the field of
PCL. The overview itself will begin with a general description of PCL config-
urations before touching upon the evolution of bistatic radar and associated
technologies. Subsequent to this, is a discussion of some advantages and dis-
advantages of current state of PCL. Next, existing models for performance
prediction are presented. The overview finishes with a look at existing PCL
receivers, focusing in particular on the direct path interference cancellation
techniques used to improve radar performance.

Following the overview of PCL, the objectives of this dissertation are given
and motivated. Finally, an overview of the work reported in this dissertation

is given.
1.1 Overview of Passive Coherent Location

The defining property of bistatic and, more generally, multistatic radar, is the
fact that the transmitter and receiver sites are not co-located. A special case
of a multistatic radar is a passive coherent location system, which is the case

where the transmitters are non-cooperative. These transmitters usually form
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part of terrestrial broadcast systems such as television and FM radio and are
commonly referred to as illuminators of opportunity and thus effectively make
such a system passive.

A bistatic PCL radar configuration is defined as a radar that has one trans-
mission and one reception site [7] separated by a considerable distance which
is comparable to the target distances [8]. Figure 1.1 illustrates a bistatic
radar configuration.

Figure 1.1: Bistatic PCL radar configuration.

A bistatic configuration is a subset of the the more general multistatic configu-
ration which employs multiple transmit and receiving sites. In current litera-
ture netted radars and in some cases multiple-input multiple-output (MIMO)
radars [9] are described as multistatic. Figure 1.2 illustrates a general multi-
static PCL radar configuration with two receivers and two transmitters. Mul-
tistatic radar is in a sense an extension of the bistatic radar configuration.

Figure 1.2: Multistatic PCL radar configuration.

The receiver node of a PCL system is required to operate as a matched filter.
This means that the transmitted signal must be available through a separate,

2



dedicated reference antenna [2]. The idea of capturing the reference signal
and comparing it to, or correlating it with, the target echo signal makes the
PCL receiver coherent [10].

As shown in Figures 1.1 and 1.2 the direct signal, in addition to the echo
signal, is incident on the receiver. In a bistatic and multistatic PCL radar, the
direct signal can seriously limit the system performance and thus is a major

factor to consider in the design of a PCL radar.

For target location information PCL radars estimate range, Doppler and pos-
sibly angle-of-arrival (AOA) [10]. Implementing a PCL radar system within a
multistatic configuration would allow for techniques of multilateration for the
determination of target location and could achieve target location accuracies

comparable to conventional radars [2].

1.1.1 The Evolution of Bistatic and Multistatic Radar

Various early forms of radar devices were developed between around 1904
and 1925 [11]. These early radars were developed and tested nearly simul-
taneously and totally independently by the United States, United Kingdom,
France, the Soviet Union, Japan, Germany and Italy [7] and were based on
a bistatic configuration. The first radar, however, was developed and demon-
strated in 1904 by a German engineer, Christian Hulsmeyer [7]. His device,
uniquely named the telemobiloscope, was able to detect ships at ranges up to 3
km. Thereafter, the development of the duplexer, which allowed transmitting
and receiving through the same antenna (i.e. monostatic radar) [1], resulted
in bistatic and multistatic radar having a checkered career with an apparent

resurgence cycle of about 15 to 20 years [8].

The latest notable resurgence occurred around 1986 with a study undertaken
by Griffiths and Long of bistatic radar based on television transmissions [12].
This latest resurgence can be attributed to vast increase ambient radio sig-
nals, particularly television and FM radio, and the technological advances in
digital signal processors and processing [1]. The work done by Griffiths and
Long was the beginning of a renewed interest in the field of passive radar.

Throughout the twenty-two years since 1986, interest in passive radar has
progressively grown, with the current resurgence cycle seemingly nowhere
near its end. Willis’s book [7] was one of the first thorough treatments of
bistatic radar. Thereafter, Howland’s early work in television based [13] and
later work in FM radio based [2] bistatic passive radar showed promising re-
sults. His FM based experimental radar system achieved ranges in excess of
150 km from the receiver. In addition, target acquisition and tracking using
passive radar was demonstrated [14, 15]. Developments of PCL radar have



also been seen in industry [16, 10]. For instance, the well-known and commer-
cially available Silent Sentry 2 (SS2) is reported to achieve ranges of up to 220
km [16]. In addition, the Thales and Raytheon joint venture ThalesRaytheon-
Systems has developed a FM passive radar, Home Alerter 100, for applica-
tions of homeland security'.

The current focus in the field PCL radar is the development of multistatic
or netted radar systems. Given one or more transmitters, multiple receiver
nodes that cooperate within a common reference frame of time and space is
the underlying principle of netted radar [17]. Synchronising these nodes to
a common reference frame can be achieved using the timing signal obtained
from a GPS constellation and is a technique being investigated by Sanden-
bergh [17].

Another current interest is in the simulation of complex radar systems and
can be attributed to the exponential rise of computing power available to en-
gineers. To this end a signal level simulator called FERS (Flexible, Extensible
Radar and Sonar), supporting a wide variety of radar systems and focusing
particularly on multistatic and netted radar, has been developed by Brooker
[18]. Simulation can provide an invaluable tool to radar researchers, engi-
neers and operators by easily reducing the difficultly and costs associated
with testing new radar technologies and approaches [18].

At this stage, however, no studies regarding prediction of bistatic and multi-
static radar performance have been done given a set of region specific environ-
mental parameters such as terrain and atmospheric conditions. Ultimately,
the proposed prediction method together with the FERS simulator are effec-
tive tools that can be used to predict the performance - in terms of coverage -
of complex radar systems and confirm the viability of PCL radar.

Lastly, an emerging and seemingly promising technology is that of MIMO
radar which shares many, but not all, the principles of netted PCL radar. Non-
coherent processing is done to exploit a target’s spatial variations to obtain a
diversity gain for a target detection and for estimation of various parameters,
such as angle of arrival and Doppler [9]. For a target location, it is shown that
coherent processing can provide a resolution far exceeding that supported by
a radar’s waveforms [9].

1.1.2 Advantages and Disadvantages of PCL

The use of bistatic or multistatic PCL radar has not always been advanta-
geous in the past. In 1977, Skolnik [19] stated that bistatic radar was of

marginal value, yet well used for special purposes. At that point he asserted

Thttp://www.thalesgroup.com/eurosatory2008/standthales3.htm, checked April 2009



that bistatic radar would not be widely deployed in the near future. This
statement was later discussed by Willis in his book [7], published in 1991.
In his discussion, Willis conceded that bistatic radar indeed possessed some
insufficiency’s. These were: Excessive complexity, high costs, degraded per-
formance in terms of coverage as well as degraded performance in terms of
low resolution and accuracy.

Advantages

The observations made by Willis and Skolnik held true for some time, though
the rapid advancements over almost two decades have lessened the severity
of these disadvantages. For instance:

e Much of the system complexity in terms of the design and implemen-
tation of bistatic or multistatic PCL receivers has been eliminated by
increased capability of digital signal processing as well as by availabil-
ity of commercial off-the-shelf (COTS) receiver parts [16].

e The costs associated with the development of a PCL system are inher-
ently low [2, 16]. Thus the implementation of an experimental PCL sys-
tem demonstrator is relatively affordable.

— Receiver parts are available COTS.

— No moving parts in the receiver necessary.

e Good coverage can be achieved with a multistatic (netted) PCL radar
system. This is made possible by efficient processing and synchronisa-
tion between nodes [17].

e Resolution and accuracy comparable to conventional radars can be achieved
by [2]:

- Exploiting excellent Doppler information, due extended integration
times possible.

- Using a multistatic or netted radar configuration. This has the ad-
vantage of providing frequency and spatial diversity.

e FM radio based bistatic radars is simultaneously unambiguous in both
range and Doppler. This useful property makes them ideal for detecting
long-range high-speed targets. [2]

Some more commonly encountered advantages to PCL in a bistatic or multi-
static configuration are listed below.



e Reduced operational and maintenance costs owing to the use of non-

cooperative transmitter.

e The receiver is passive and thus it is less vulnerable to electronic coun-
termeasures (ECM) [1]. Namely, the fact that the PCL receiver is not
transmitting makes it covert and thus difficult to detect.

e PCL offers a counter to stealth technology that is primarily designed to
defeat monostatic radar [1].

Disadvantages

The disadvantages associated with a bistatic or multistatic PCL radar have
not changed much with time. To a large extent a monostatic mindset [7] is a

major limitation to advancements in bistatic and multistatic radar.
e The use of a non-cooperative transmitter allows no control over:

— The transmitted waveform. This includes waveform type, band-
width and power. In particular, the range resolution of FM-based
PCL is generally worse than achieved in conventional systems ow-
ing to the low and variable station bandwidth [20].

— The location of the transmitter. This puts the broadcast transmit-
ter at risk of an Attack Reconnaissance Helicopter (ARH) attack,
compromising the entire PCL system when operating as a military
radar. Furthermore, Low Probability of Intercept (LPI) techniques
commonly used to improve the survivability of conventional radars

cannot be applied to broadcast non-cooperative transmitters [21].

e Direct path interference from the illuminating transmitter can saturate
the PCL receiver. This is a particular problem when there is direct line-
of-sight (LOS) from transmitter to receiver. In this case the PCL receiver
must take measures to attenuate the transmitting signal by Doppler

filtering, spatial nulling or by terrain masking [7].

e Geometric complexity [7]. It is difficult to comprehend how the terrain
of a certain location of interest can vary appreciably. As a result the
computation of spatial coverage and consequently the performance of a
PCL system is non-trivial. In comparison, the performance of a mono-
static radar is easier to characterise as the shadow regions are easily
identified.



e The costs associated with the development of a PCL system required to
conform to military specifications can increase rapidly[21]. Such a sys-
tem may require multiple nodes (a multistatic system) to ensure com-
plete radar coverage. In addition, the use of an array antenna and adap-
tive cancellation processing for the suppression of interfering signals has
the implication that the receiving system is not as simple nor as cheap
as might originally have been supposed [22].

1.1.3 Modelling of Predicted Performance

A major factor in PCL is the choice of transmitted waveform, location of the
transmitter and the location of the PCL receiver system. These must be cho-
sen so as to maximise the coverage of a particular bistatic radar configuration.
Furthermore, since the radar is passive, the location of the transmitter and
the form of transmission to be exploited are no longer under the control of
the radar designer. Thus it would seem that the scope for radar design and
optimisation is severely limited [1].

However, bistatic PCL performance predictions can be done for any bistatic
configurations in free space. One such prediction is shown in Figure 1.3. This
prediction, shown in Cherniakov’s book on bistatic radar [1], is of a FM based
passive bistatic radar and is a result of Griffiths and Baker’s original paper
[22] investigating potential detection range and PCL performance of realistic
systems. The figure shows the detection range and coverage in free space in
terms of signal-to-noise ratio (SNR) and is in the form of the well-known ovals
of Cassini [7].

< 10 Chval of Cassini W.EIUGCL In P Pt=250KW

range (m)

[+ ]
= £

g e R M ol
range (m) o 10

Figure 1.3: Detection range for a transmitter at Wrotham in South-East Eng-
land and a receiver at UCL [1].

The minimum required SNR, as illustrated in Figure 1.3, could be related to
a specific probability of detection, P;, and probability of false alarm, P, [8].
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These probabilities would be specified by the system requirements as derived
from a customer’s needs; however are currently not well-defined for passive
bistatic systems in open literature and offer an avenue for future work. An
SNR of 15dB is generally accepted as a good benchmark for bistatic radar
and PCL utilising broadcast FM radio signals [22, 2]. With an SNR specified
around 15 dB and a target RCS set at 10 dB Tobias et al [23] determined a
Py = 0.9999 and Py, = 10~* for a passive bistatic radar at low frequencies for
their simulations.

A common problem in bistatic PCL systems is that the radar receiver must
detect very low power target echoes in the presence of a very strong and con-
tinuous broadcast signal [1]. This could be said to be the greatest limiting fac-
tor in PCL systems, where direct-path interference (DPI) can in some cases
be up to 90 dB greater than the echo [2]. A measure of the severity of this
effect is the signal-to-interference ratio (SIR) and describes the required dy-
namic range of the receiver, in particular the dynamic range of the ADC. A
commonly accepted level of SIR of a receiver is between —60 dB and —70 dB.

Figure 1.4 shows the predicted signal-to-interference ratio (SIR) for a specific
FM based bistatic radar in free space. In this case the receiver has a particu-
lar antenna pattern that is taken into account, thus providing a non-uniform
coverage pattern as seen in the figure.

=100 —150 0 100

Figure 1.4: Predicted signal-to-interference ratio (dB) [2].

Using spatial maps of SNR and SIR data gives a good indication of the ex-
pected performance of a particular bistatic radar configuration and aids in
identifying critical factors. As such, this method of visually representing the
coverage of a bistatic PCL system provides a good figure of merit or tool to
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determine the performance.

However, one major drawback to the aforementioned methods is that they are
performed in free space with environmental effects not taken into account.
The greatest environmental effect, of course, is that of terrain. The fact that
the transmitter-to-target and target-to-receiver paths may not always be line-
of-sight (LOS) is a significant aspect to consider. In addition, other significant
propagation effects are multipath, diffraction, refraction and atmospheric ab-
sorption and cannot be disregarded. In the case of the Western Cape region
the effect of the environment - in particular that of the mountainous terrain -
on EM wave propagation is an important factor to take into account.

The ability to model and subsequently predict the possible detection range
and coverage feasibility, by producing spatial SNR, SIR as well as SNIR (signal-
to-noise-plus-interference) maps while taking the environmental propagation
effects into account, provides an improved method for determining the perfor-
mance of a bistatic PCL radar. It also allows for the identification of optimum
receiver sites in order to maximise coverage and would in essence provide a
powerful planning tool for an Air Traffic Control system.

1.1.4 Receiver System Designs

As was noted in the previous section, a strong DPI received in the target an-
tenna correlates perfectly with the reference signal and can produce range
and Doppler sidelobes that are several orders of magnitude greater than that
of the wanted echo [2]. This makes receiver system design particularly impor-
tant in the field of PCL.

Much work has been done concerning the cancellation of DPI. Software can-
cellation, namely, the cancellation implemented in the digital domain occurs
last in the target echo receiver chain as indicated in Figure 1.5 and has been
the subject of much attention. However, software cancellation cannot increase
the target information in the quantised data obtained from an ADC with a
limited dynamic range. Thus, used alone, software cancellation won’t im-
prove the performance of the passive radar significantly [24]. As such, Wan
[24] stresses the importance of DPI cancellation prior to ADC for improve-

ment of passive radar performance.

There are generally two effective techniques that enable DPI cancellation be-
fore the ADC as shown in Figure 1.5. One technique is to introduce a type
of RF canceller and the other is to suppress the interference in an antenna
pattern null using pattern synthesis techniques. The ability to synthesise the
receiver antenna pattern has the advantage of being able to point the main
beam in the region of interest while suppressing interfering signals from ar-
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Figure 1.5: Target echo receiver chain.

bitrary directions in nulls.

Dynetics [10] reports the effective implementation of a PCL system and sup-
pression of the DPI using a RF canceller. Their RF canceller was able, with
manual adjustments, to attenuate the DPI by 20 dB. To eliminate clutter re-
turns with zero Doppler shift, they delayed the reference signal, appropriately
adjusted its gain and phase, and subtracted it from the target signal. The re-
sult was the elimination of all signals with zero Doppler shift. This technique
proved quite effective and allowed detection of the desired aircraft targets as
long as their Doppler shifts are non-zero. Real experiments done by Wan et al
[24] with their RF cancellation stage gave a suppression of DPI of over 30 dB.

In terms of the target antenna front-end as illustrated in Figure 1.5, a com-
mon method to suppress the direct signal has been the use of adaptive anten-
nas, namely the steering of nulls in the direction of the illuminating transmit-
ter. Other less sophisticated - yet often successful - methods involve simply
shielding the target antenna from the transmitter or using directive antenna
elements focused in a particular direction.

For instance, Sahr and Lind, in their work on the Manatash Ridge radar
designed for upper atmosphere radio science, isolated the receiver from the
direct signal by physically displacing the target antenna from the transmitter
by approximately 100 km, past an intervening mountain range [25].

In his work on TV based bistatic radar [14], Howland used two directive eight-
element Yagi-Uda antennas to achieve an unambiguous measurement range
of approximately +56° about boresight. In this case the direct signal simply
fell outside the main beam and on the pattern sidelobes of lower gain. Later,
Howland used a receiver that comprised of two vertically-polarised half-wave
dipoles over a mesh backplane for his investigation into FM based bistatic
radar [2]. This yielded a radar that surveyed a sector approximately 120° in
the azimuth. In this case, in order to suppress the DPI, the target antenna
was physically oriented so as to try and place the transmitter in a null in the
antenna pattern.

Dynetics [10] ultimately also made use of Yagi-Uda antenna for their target
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antenna and similar to Howland [14] ensured that the direct signal fell out-
side the main beam. In their work they attempted, when possible, to place
nulls in the direction of the transmitter.

The Silent Sentry 2 system employs a linear phased antenna array as their
target antenna [16]. This allows them some control over their antenna ar-
ray pattern and as such enables them to form nulls in the direction of the

illuminating transmitter to suppress the DPI.

It is apparent that much work has been done regarding the investigation of
RF cancellers and, in contrast, less regarding the shaping of antenna array
patterns to suppress DPI. The opinion of Wan [24] and Zoeller of Dynetics [10]
is that interference cancellation cannot be solely achieved by antenna synthe-
sis techniques. However, arraying of antennas can offer an improvement of
DPI suppression before the ADC. Namely, inefficient use of the target anten-
nas could be detrimental, whereas effective implementation of an antenna
array can offer performance improvement. Thus, the antenna front-end and
the methods of antenna pattern synthesis are important aspects that must
not be disregarded.

1.2 Objectives and Motivation

The objectives of this dissertation are to:

e Investigate the broadcasting platforms of the Western Cape in order to:

— Identify transmitters that may be used as illuminators of opportu-
nity.

— Identify broadcast signals suited for use by a PCL system.

e Determine a method for predicting the performance of a PCL system in
terms of detection range and required dynamic range with real-world
environmental effects taken into account. The predictions are to be done
using:

- Signal-to-noise ratio (SNR) spatial coverage maps.
- Signal-to-interference (SIR) spatial coverage maps.

- Signal-to-noise-plus-interference (SNIR) spatial coverage maps.

e Investigate methods of antenna array synthesis to improve the predicted

performance of a PCL system.

e Conclude on work done and discuss possible future research.
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Before the development of any PCL system, a good knowledge of the available
transmitters and signals of the specified region is required. Therefore, the
characterisation of the broadcasting platforms within the Western Cape is an
important starting point for this dissertation.

PCL has proved to be feasible in a number of experimental systems, but the
lack of comprehensive, published flight trials detracts somewhat from serious
consideration of these PCL systems for operational applications, such as Air
Traffic Control (ATC). The carrying out of flight trials is, in any case, difficult
and very expensive. Hence, an improved method of performance prediction for
a PCL system, that accounts for the effects of the environment, is proposed
in this dissertation. These performance predictions, in the format of spatial
signal-to-noise ratio (SNR), signal-to-interference ratio (SIR) and signal-to-
noise-plus-interference ratio (SNIR) maps, provide a powerful planning tool
for the application of systems such as ATC and would offer an extension to
the work reviewed in Section 1.1.3.

It is clear from the discussions in Sections 1.1.3 and 1.1.4 that the direct
path signal is the cause of some severe limitations within a PCL system. In
the interest of suppressing this strong direct signal before the ADC, antenna
pattern synthesis techniques will be investigated in order to place a null in
the direction strong transmitters. The synthesised antenna pattern and its
improvement on the performance of the PCL system can then evaluated using
the proposed prediction tool. Provided reasonable performance the array will
be set up and its radiation pattern tested.

In general, the widespread acceptance of the PCL technology requires much
more confidence from the user community. For example, in terms of predicting
and measuring coverage, modern ATC radar systems (expensive on spectrum
usage and cost) leverage a heritage going back to the 1939-1945 War. Compre-
hensive coverage studies of operational bistatic, multistatic and PCL systems
have not been widely published, if at all available.

1.3 Overview of dissertation

Chapter 1 provides a brief overview of the field of PCL. It includes a dis-
cussion of PCL configurations, the evolution of bistatic radar and associated
technologies as well as some advantages and disadvantages of the current
state of PCL. Existing PCL receivers are reviewed in this Chapter, focusing
on interference cancellation techniques and models for performance predic-

tion.

Following the overview of PCL, the objectives of this dissertation are given
and motivated. Finally, the current section provides an overview of the work
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done, essentially giving a summary for each chapter.

Before the development of any PCL system, a good knowledge of the available
transmitters and signals of the specified region is required. As such, a pre-
liminary study into the properties of the broadcast transmitters and signals
of the Western Cape, with the effects of the environment taken into account,
was done and is reported in Chapter 2.

The purpose of this chapter is to identify and characterise the regional broad-
cast transmitters and their associated signals so as to determine the feasi-
bility for their use as illuminators of opportunity. In particular, one trans-
mitter is sought for the later application and investigation of an improved
performance prediction method proposed in this dissertation and introduced
in Chapter 3.

Chapter 2 begins with a review of some important environmental effects.
Thereafter, the electromagnetic (EM) propagation modelling tools, APM and
AREPS?, are introduced and discussed. A central topic of this chapter and
dissertation is the use of APM and AREPS to allow accurate modelling of EM

waves propagating within the environment of the Western Cape.

Next, the signal and transmitter properties of possible illuminators of oppor-
tunity are studied. This involves a comparison and discussion of the signal
strength received at UCT, for the free space, measured and simulated case.
The study ultimately identifies the Villiersdorp transmitter as the best-case
illuminator of opportunity. It’s location, which is out of line-of-sight due to
some mountainous terrain, is seen to provide additional attenuation of the
direct signal and thus additional suppression of the DPI. The Villiersdorp
transmitter will be used throughout this dissertation as the illuminator of
opportunity for all ensuing case studies.

Chapter 3 presents the proposed method of predicting bistatic PCL perfor-
mance, while accounting for environmental effects. The performance predic-
tion, in the form of spatial signal-to-noise ratio (SNR), signal-to-interference
ratio (SIR) and also signal-to-noise-plus-interference ratio (SNIR) coverage
maps, provide a visual means for determining radar detection range and re-
quired dynamic range of the receiver. Using this method, expected coverage
at different altitudes with specified transmitter and receiver properties is de-
termined and compared with the conventional prediction method employing
the ovals of Cassini. The method, which is essentially an extension to the
work of Griffiths and Baker [22], provides the user with a means to compare
the coverage of potential illuminators of opportunity quickly and easily.

The coverage maps produced here are based on an interpolation of propaga-

2Advanced Propagation Model (APM) and Advanced Refractive Effects Prediction System
(AREPS)
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tion loss data generated by APM and AREPS. Namely, realistic propagation
loss is utilised to predict the loss along any path from a transmitter to a tar-
get and onwards to a receiver. This is achieved by taking into account the
propagation factor, /', which is a quantity that commonly contains the effects
of refraction, diffraction, multipath as well as atmospheric attenuation dealt
with in the previous chapter.

To model the loss from a moving target to a receiver is difficult, since radar
coverage prediction requires this to be done for all possible target positions, to
the receiver. By appealing to theorem of reciprocity [4], the target to receiver
loss is modelled in the reverse direction. It is thus possible to map the two
way loss to each pixel of the area being assessed in one set of calculations,
the results of which can be held as a lookup table for simulation or coverage
assessment. The method’s accuracy will degrade slightly in the case of targets
lying in shadow regions subject to knife-edge diffraction.

This chapter begins by discussing the SNR, SIR and SNIR equations, derived
from the well-known bistatic radar equation, for the purpose of coverage pre-
diction. This is followed by a discussion of a conventional model of bistatic
coverage, the ovals of Cassini. The proposed method of determining expected
bistatic PCL radar coverage, while accounting for environmental effects, is
then developed. Throughout this chapter a omnidirectional target antenna
pattern with a gain of 5 dB is used.

The SNR coverage maps show an expected coverage, for given environment
and system parameters, of around 75 km and 150 km at an altitude of 1600 m
and 5000 m, respectively. These realistic detection ranges were, as expected,
much less than the 250 km detection range predicted using the conventional
model. These differences emphasised the importance of the propagation fac-
tors, F'.

The SIR (and SNIR) coverage maps indicated the required dynamic range
within a certain coverage region. An improvement, of around 25 dB, in the
SIR coverage maps and subsequently the required dynamic range was seen
by the increase of direct path loss resulting from the terrain and atmosphere
effects. The required dynamic range can be further improved by reducing the
DPI in the target antenna.

In general, this method can be used to compare various arrangements of
receivers and transmitters in any bistatic configuration and will aid in the
choice of optimum non-cooperative transmitter and receiver location. In essence,
it offers improved performance prediction capability over the conventional
prediction method.

Chapter 4 will present the modified coverage of expected detection range and
required dynamic range in terms of SNR and SIR resulting from the target
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antenna pattern synthesis. In particular, the Schelkunoff method is used to
synthesise a pattern null in the direction of the illuminating transmitter to
suppress the DPI in the target antenna of a PCL receiver. The case study
introduced in the previous chapter is carried through here, in that an attempt
to improve the coverage is made.

The chapter begins by listing necessary requirements for target antenna ar-
ray.

Thereafter, target antenna array and its elements are simulated and dis-
cussed with the use of the sophisticated antenna and EM modelling tool,
FEKO®. The name, FEKO, is derived from a German acronym which can be
translated as "Field Computation for Objects of Arbitrary Shape".

First, folded dipoles, intended for the use as the elements of the target an-
tenna array, are discussed. The choice of folded dipoles as elements of the
array is found advantageous in that they are structurally stable and commer-
cial available.

Next, the antenna pattern synthesis technique, the Schelkunoff Unit-Circle
Method, is introduced and reviewed. With reference to the requirements,
the target antenna array is designed using this technique and simulated in
FEKO. The resulting four element array is investigated, with a particular
focus on the subsequent azimuth radiation pattern. Applying a Schelkunoff
excitation distribution to the four element array within FEKO results with a

null in the expected direction.

Utilising the azimuth pattern with resulting from Schelkunoff distribution in
the performance prediction method presented in Chapter 3, shows improved
coverage in the sectors of interest. The decrease of coverage in other sectors
was deemed acceptable for the application of the detection of aircraft in the
direction of JHB. In general, the results suggest that coverage, in terms of
possible detection range and required dynamic range, in a sector of airspace
can be improved significantly with the application of antenna synthesis.

In Chapter 5 the antenna array excitation determined in the previous chap-
ter will be applied to real folded dipole antenna elements representing the
target antenna. This is done for two reasons. Firstly, to verify the simulated
pattern and to confirm that the application of the Schelkunoff method used
in the previous chapter yields a physically realisable pattern. Secondly, to
ascertain the predicted performance in terms of detection range and dynamic
range resulting from the measured pattern. The bistatic configuration inves-
tigated here is a continuation of the case study dealt with in Chapter 3 and
4. The predicted performance determined here is compared with that of the

simulated case determined in the previous chapter.

3www.feko.info, checked 6 February 2009.
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This chapter begins with a description of the components that make up the
target antenna array. Important characteristics of each of the components are

noted and their configuration making up the receiver system is also discussed.

Thereafter, aspects concerning the measurement of the antenna array are
dealt with. To begin with, a brief description of important measurement pre-
liminaries are given. Namely, the setup of equipment as well as the proposed
measurement procedure are described. Following the measurement proce-
dure the measured pattern is presented and observations made.

The final results of this chapter suggest that Schelkunoff’s Unit Circle Method
is an effective technique for the purpose of null placement. Furthermore, this
coupled with the good agreement of the simulated and measured patterns
confirms that the application of Schelkunoff Method in Chapter 4 yields a
physically realisable pattern.

The measured pattern was used as the receiver pattern within the perfor-
mance prediction model. The results suggested a relatively similar decrease
in expected coverage in terms of radar detection range, for an SNR of 15 dB.
The decrease was slight from the results seen in Chapter 4, yet as s expected
due to the slight discrepancy in the main lobe of the gain pattern. How-
ever, good coverage comparable to existing experimental systems was still
predicted.

Chapter 6 and Chapter 7 will provide and discuss the conclusion and future
work of this dissertation respectively.
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Chapter 2

Transmitter and Signal
Environment Investigation of
the Western Cape

Before the development of any PCL system, a good knowledge of the available
transmitters and signals of the specified region is required. As such, a pre-
liminary study into the properties of the broadcast transmitters and signals
of the Western Cape, with the effects of the environment taken into account,

was done and is presented here.

The purpose of this chapter is to identify and characterise the broadcast trans-
mitters and their associated signals so as to determine the feasibility for their
use as illuminators of opportunity. Consequently, a list of potential illuminat-
ing transmitters will be formulated and critically discussed. In particular,
one transmitter is sought for the later application and investigation of an
improved performance prediction method proposed in this dissertation and
introduced in Chapter 3. In addition to this, the work presented in this chap-
ter will lend itself well to the ultimate goal of implementing a PCL receiver
at the University of Cape Town (UCT) in the future.

This chapter begins with a review of some important environmental effects.
Thereafter, the EM propagation modelling tools, APM and AREPS, are in-
troduced and discussed. A central topic of this chapter and indeed this dis-
sertation will be the use of APM and AREPS to allow accurate modelling of
EM waves propagating within the environment of the Western Cape. Next,
the signal and transmitter properties of possible illuminators of opportunity
are studied. This will involve comparing and discussing, the signal strength
received at UCT, for the free space, measured and simulated case before the
final conclusion of this chapter.
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2.1 Environmental Effects on Propagating Waves

A propagating wave is subject to a variety of environmental effects that can
alter its amplitude and phase [26]. These propagation effects generally re-
sult in a reduction of the received signal power, and thus limit the possible
coverage range. This section serves as brief review and discussion of some
important effects. The book by Barton [3] gives a good concise overview of the
effect of the environment on a propagating wave and forms the basis of this
section. The environmental effects of interest in this dissertation include:

e Multipath
e Diffraction
e Refraction

e Atmospheric absorption

2.1.1 Multipath

Multipath interference, is the most important non-free-space effect and can
result in very considerable increase or decrease of the radar detection range
compared with the free-space range [19]. The multipath effect is the modi-
fication of the expected free-space field at a particular point in space and is
the result of a reflection of the propagating waves beneath the direct path [3].
The distances travelled to a particular point in space by the two waves (direct
and ground reflection) are not equal and thus result in a phase difference. It
is this phase difference that is primarily responsible for the multipath effect
[19]. Additional phase difference is contributed by the reflection coefficient of
the reflecting surface [19]. A list of different surface conditions is given in Bar-
ton [3]. The phase difference will cause the two waves to add constructively
or in the usual case destructively.

(a) (b)

Figure 2.1: Direct propagation path and ground reflection path illustrating
multipath effect between transmitter and receiver [26].
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Figure 2.1 illustrates the basic concept of multipath for the transmitter-to-
target (a) and target-to-receiver paths (b), for the illuminating and reflected
wave respectively. These paths will not be the same, namely the propagating
waves will travel over different terrain, and thus will possess different multi-
path effects. Furthermore, the multipath effect will continually change for a

different target positions.

2.1.2 Diffraction

In terms of diffraction, energy tends to follow along the curved surface of an
object, such as the earth. Namely, diffraction is the process by which the
direction of the propagating wave is changed so that it spreads into the geo-
metric shadow regions of an opaque obstacle or beyond the optical horizon of
the earth. The ability of the propagating wave to do so is highly dependent
upon frequency [27].

Figure 2.2: Comparison of diffraction effects [3].

Knife-edge diffraction is a special case where the diffraction is more pro-
nounced, as a consequence of obstacles projecting well above the surface, as
in the case of mountains and ridges. As illustrated in Figure 2.2, these will
establish a horizon at a masking angle above that established by a smooth
sphere. Below the mask angle, the factor F' (described in Section 2.2), drops
to zero more slowly than for the smooth sphere, enabling some radars to de-
tect targets in shadow regions [3].

This capability, which is better for longer wavelengths has been exploited in
existing radars and communication systems as obstacle gain [3], but is not
an improvement to line-of-sight (LOS) propagation. The effect of knife-edge
diffraction is of particular importance in the Western Cape, due to its moun-

tainous terrain.
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2.1.3 Refraction

The term refraction refers to the property of a medium to bend an electro-
magnetic wave as it passes through the medium [27]. Atmospheric refraction
causes radar waves passing through the earth’s atmosphere to bend down-
ward, as seen in Figure 2.3, due to the changing refractive index of the tropo-
sphere and then by the ionosphere. In terms of radar this produces an error
in the elevation angle, the ray having a somewhat larger angle than the direct
geometrical path to the target [3].

Figure 2.3: Ray path through the atmosphere [3].

For the troposphere which extends up to around 12 km [27], the usual region
for most aircraft (commercial and military), three effects must be considered

[3]:

Regular Refraction The gradual reduction in refractive index with altitude

and causing elevation and range bias errors.

Tropospheric Fluctuations Random variations in the local refractive in-

dex and the cause of slow varying errors in all measured coordinates.

Ducting The result of steep gradients - usually found near the surface - in
refractive index, creating low-loss propagation paths to low-altitude tar-
gets.

2.1.4 Atmospheric Absorption

Atmospheric attenuation or absorption is almost negligible at the lowest radar
frequencies. It becomes more significant in the microwave bands and imposes
severe limits on radar operation in the millimetre-wave bands [3]. For the
application of FM based PCL radar, the attenuation rate in clear atmosphere
is less than 0.012 dB/km and does not increase by much in the case of heavy
rainfall (100mm/hr).
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2.2 Propagation Loss Modelling Tools - AREPS
and APM

The Advanced Propagation Model is a hybrid ray optics and parabolic equa-
tion propagation model, applicable to a range of frequencies from 2 MHz to
57 GHz. APM is the propagation model used within AREPS [27]. The goal
in development of APM was to create an all-encompassing propagation model
for the incorporation into the U.S. military’s electromagnetic performance as-
sessment systems. In addition to its use by the U.S. military and other U.S.
government agencies, APM and AREPS are well-proven [28] and widely used

by academic institutions and foreign agencies across the world [29].

The advantageous feature of the APM and AREPS software is their ability to
compute the propagation factor, which is defined as the ratio of actual electric
field strength created at a point in space to the field strength that would have
been created by the same system operating in free space, with the beam of
the transmitter directed towards the point in question [27, 3]. This ratio is
represented by,

_ 1Bl

F—
| Eo|

(2.1)

where |Ey| is the magnitude of the electric field under free-space conditions,
and |E| is the magnitude of the field to be investigated at the same point.

The propagation factor, I, accounts for factors such as sea-surface reflectiv-
ity, atmospheric absorption and refraction, diffraction and multipath effects
caused by terrain (discussed in the previous section). This factor is a use-
ful quantity as it is an identifiable parameter in most radar range equations
[27, 3, 7, 19]. The total real propagation loss would be found by combining the
propagation factor, F', with the free space path loss, L, as given by,

L = Ly, — 201og,y(F) (2.2)

By default, AREPS accepts the digital terrain elevation data (DTED) for-
mat. This elevation format was derived ' from height maps obtained from
the SRTM90 > database. The terrain data in used in this dissertation DTED

level 1 format and corresponds roughly to 100 m of horizontal resolution.

Figure 2.4 shows the output given by AREPS. Shown is the propagation loss
computed over a specified height and range for a particular azimuth bearing.
In this case the height and range limits are 5000 m and 126 km respectively
with the propagation path specified in the direction of the Menzies building at

IThe conversion process is detailed in Appendix A
2http:/srtm.csi.cgiar.org/, checked 27 July 2008
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Figure 2.4: AREPS propagation loss over range and height above sea level in
a particular azimuth direction.

UCT. In this figure the effects of knife-edge diffraction as discussed in Section
2.2 can clearly be seen.

Thus, given relevant regional terrain and atmospheric data AREPS and APM
provide an effective tool to accurately compute the propagation loss associated

with ones region of interest.

2.3 Properties of an Illuminator of Opportunity

There are numerous properties to consider when choosing an illuminator of
opportunity. For instance, the transmitters are non-cooperative and as such
their parameters such as location, power, signal waveform and beamwidth
cannot be altered. In this section, signals that offer potential for use in a
PCL radar system are investigated. Thereafter, properties of the illuminat-
ing transmitters emitting suitable signals are considered. The parameters
of these transmitters stationed throughout the Cape region were kindly pro-
vided by Sentech [30] but can also be found in [6].

2.3.1 Signal Properties

The rapid growth in RF emissions for television (TV) and radio broadcasts as

well as terrestrial (mobile and fixed) communications and space-based com-
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munications, has resulted in in a wide range of signal types being available for
exploitation by passive radar. Furthermore, many such transmissions are at
VHF and UHF frequencies. This allows these parts of the spectrum not nor-
mally available for radar use, and at which stealth treatment of targets may
be less effective, to be used [1]. In particular, at frequencies below 1 GHz,
the materials used for a stealth target are less effective and the shaping is
less influential at reducing the RCS owing to comparable size of the signal
wavelength to the target structures [21].

In this dissertation as in the majority of other research [1], the signal emis-
sions of the commercial broadcast transmitters are of interest, due to their
high powers, attractive locations and density of deployment. For instance, in
the region surrounding Cape Town there are over 200 different TV and FM

radio signals emanating from 25 known broadcast transmitters.

Table 2.1: Frequency assignments in South Africa [6].

Broadcasts Frequency Band Number of | Channel
Band [MHz] Number Channels Width

VHF/FM Sound 87.5-108 Band II 204 100 kHz
VHF Television | 174-238 and 246-254 Band III 9 8 MHz
UHF Television 470-854 Band IV and V 48 8 MHz

The Independent Communications Authority of South Africa (ICASA)? facili-
tates and controls frequency assignments within South Africa. It has ensured
that the frequency plans and levels of spectrum usage in South Africa are
based on and are consistent with internationally accepted practises desig-
nated by the International Telecommunications Authority (ITU) [6]. As such
the frequency bands assigned for FM radio and TV, given in Table 2.1, are
similar to those found globally.

In terms of the signal waveform proposed for use throughout this dissertation,
the FM radio emissions are chosen over the television emissions. Despite the
appeal of the pulse-like waveform structure of TV emissions, it was found that
the waveform is not suitable for radar usage in a conventional radar matched
filtering approach [2] (Howland reporting on Griffiths [12]). In a TV based
bistatic radar target location and tracking is possible but becomes a difficult
task [1, 14]. In contrast, FM broadcast signals have properties that make
them attractive radar waveforms [10] and are the most common signals used
in PCL radars to-date [1].

As is shown in Table 2.1, a FM radio broadcast occupies 100 kHz of band-
width. A 100 kHz signal would translate to a range resolution of 1500 m as
given by the approximation ¢/25 [2]. In reality, the actual bandwidth value de-

3Website: www.icasa.org.za
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pends upon program content and audio volume. Consequently, the bandwidth
and thus the performance of the radar are a function of time [1].

The typical 3 dB modulation bandwidth observed by Zoeller of Dynetics [10]
for the music genres rock, pop and country is about 60 kHz. A modulation
bandwidth of 55 kHz is in some cases said to be typical [1], which agrees rela-
tively well with that of Zoeller. Furthermore, research has shown fast-tempo
jazz to have a small bandwidth of about 24.4 kHz [1]. Typical values of FM
radio bandwidth provide a usable yet somewhat mediocre range resolution
between 1500 m and 2500 m. In the case of jazz the range resolution is about
6000 m which is relatively poor.

Figure 2.5 shows the measured FM signal bandwidth for the 5FM radio sta-
tion emitted by the broadcast transmitter located on the Constantiaberg moun-
tain overlooking Cape Town. The transmission content comprises primarily
of rock and pop. As such, the 3 dB modulation bandwidth measured is about
60 kHz, which is in close agreement with that of Dynetics [10].

Amplitude [dB]

88.8 88.85 88,9 8895 89 82.05 892.1 89.15 8%9.2

Freguency [MHz]

Figure 2.5: Measured FM signal bandwidth of the radio station 5FM at 89
MHz.

However, the suitability of a signal for target location is governed by more
than its bandwidth. Of more importance is the ability of the radar receiver
to unambiguously locate the target [2]. Commercial FM broadcast signals are
generally said to be random phase-modulated waveforms [10] with noise-like
characteristics [2]. As such, their ambiguity function is approximated by the
ideal “thumbtack” ambiguity function, which is an attractive feature of using
FM signals over TV [10].
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This attractive feature is a result of the excellent Doppler accuracy achieved
owing to the extended integration times possible with FM signals. In some
cases Doppler can be two to three orders of magnitude more accurate than
conventional microwave radar [2]. The Doppler resolution can be calculated

by,
1

71z'mt

where T}, is the integration time. A rule of thumb for the maximum value of

0fs= (2.3)

the coherent processing integration interval is,

A\
Thax = <A_R) (2.4)

where Ay is the radial component of the target acceleration [1]. For instance,
in the case of a commercial aircraft possessing low acceleration, an integra-
tion time of 1 second would be reasonable. This coherent processing integra-

tion interval also provides a processing gain [1] governed by,
Gp - TMAXB (25)

and together with a signal bandwidth B of 60 kHz, as shown in Figure 2.5,
would provide a processing gain of 48 dB.

The limits on the range and Doppler resolutions can be evaluated by measur-
ing the transmitted waveform and computing the ’self-ambiguity’, a method
covered in the book edited by Cherniakov [1]. The range and Doppler resolu-
tions are initially computed by matched filtering the directly received trans-
mitter signal. It is called the ’self-ambiguity function’ as the relative positions
of the target, transmitter and receiver are not taken into account. The ’self-
ambiguity’ enables the best achievable range and Doppler resolutions to be
evaluated and the time-varying properties to be investigated. This method is
currently being used by a colleague to further characterise the transmitters
and signal waveforms of the Cape region.

Lastly, a practical issue concerning the Western Cape region is that of dupli-
cate carrier frequencies. The region requires that there be more lower power
transmitters to fill the various gaps in the coverage caused by the mountain-
ous terrain as apposed to few high power transmitters for regions of flatter
terrain. Consequently, out of the seemingly many available frequencies, as
shown in Figure 2.6, only a select few are useful for the application of a PCL
radar system. Using a frequency of which there is a duplicate in the vicinity

can cause mutual interference.
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Figure 2.6: Spectrum of the FM broadcast signal band measured from UCT
in Cape Town.

2.3.2 Transmitter Properties

Major factors that influence the choice of illuminating transmitter for an ef-
fective implementation of a PCL receiver located at UCT are specified below:

e Location of the transmitter.

Flight Routes of commercial aircraft in the region.

Effective radiated power (ERP) of the transmitter.

Beamwidth of transmitting antenna.

Line-of-Sight between transmitter and PCL receiver.

e Geometry for bistatic Doppler.

Aside from the signal waveform requirements and properties, the choice of an
illuminator of opportunity can become a convoluted process as it depends on
the combination and interaction of all the factors listed above. For instance,
the location of the transmitter would certainly have an effect on the line-of-
sight to the receiver and the target.

In this dissertation, the focus will be on the potential detection of commercial
aircraft (the targets) en route with the Cape Town International (CPT INTL)
Airport for the possible purpose of ATC. For this reason, common flight routes,
of aircraft within the Western Cape, are important. As a further example of
the interdependency’s of the aforementioned factors, the illuminating trans-
mitters are required to possess reasonable coverage of these routes.
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Transmitter Locations

Taking into consideration the discussion of signal waveforms in Section 2.3.1
above and disregarding transmitters of lower transmit power, 6 transmitters
were identified as having potential for use as illuminating transmitters. Fig-
ure 2.7 shows the locations of the transmitters, more or less uniformly spaced,
within the Cape region; it also shows the locations of the CPT INTL Airport
and UCT - the proposed site of the PCL receiver. The distances and bear-
ings to these locations as measured from the receiver site at UCT are given in
Table 2.2.

The geographical projection used in Figure 2.7 is Universal Transverse Mer-
cator (UTM) and will be used throughout this dissertation. The UTM system
divides the earth into 60 zones, each 6 degrees of longitude wide. A square
grid is superimposed on each zone and aligned so that the vertical grid lines
are parallel to the central meridian. The grid used in this projection is met-
ric and can be assumed to be Cartesian within each zone, where each zone
is never more than 674 km wide. The fact that projection can be assumed

Cartesian makes range and bearing calculations simpler.
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Figure 2.7: Location of the PCL receiver and airport as well as the locations
potential illuminators of opportunity within the Western Cape.

Correct siting of the PCL receiver is critical to system performance [10]. Thus,
the proposed siting of a PCL receiver on the roof of the Menzies building at
UCT was not without consideration. The site, while convenient, has good
elevation in addition to a wide field of view in an easterly direction. Fur-
thermore, this field of view contains the location of the airport as well as the
major domestic flight paths (as shown in Figure 2.8). Inversely, given a PCL
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receiver siting, the selection of an illuminating transmitter, with considera-

tion towards its location, is equally important.

Table 2.2: Distances and Bearings from UCT to the Airport and Potential
IMluminating Transmitters.

Location Distance | Bearing Referenced
Name [km] to True North [°]

Airport 12.8 92.4
Constantiaberg 12.6 210.8
Ceres 121.3 48.7
Matjiesfontein 204.1 67.6
Piketberg 129.0 10.3
Tygerberg 15.6 52.3
Villiersdorp 96.8 89.6

Flight Routes of Commercial Aircraft

Figure 2.8 shows the major flight routes of aircraft en route with CPT INTL
Airport. Other flight routes, in the northerly and westerly directions, exist
but are used mostly by international flights and thus less frequently. Of in-
terest, and shown in Figure 2.8, are the major domestic flight paths of aircraft
arriving and departing at CPT INTL Airport.

—®—|nbound - JHB
6400 —®—Outhound - |HB
—&— |nbound - PE
—4&— Qutbound - PE
63501 ® CPT INTL Airport
® Receiver (UCT)

6300
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Northings [km]

6200" I e Okted Nevir -
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6150 _I 1 1 1 I\.”. 1
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Figure 2.8: Flight paths of aircraft during approach and departure from Cape
Town International Airport.
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Two major routes in and out of the Cape Town airspace were identified using
aeronautical charts [31]. These are in the general directions of Johannesburg
(JHB) and Port Elizabeth (PE) and can be seen in the figure, where the in-
bound and outbound air traffic for both the JHB and PE routes are blue and
red respectively. The routes are designated with waypoints where the circular
markers in the figure indicate the JHB routes and the triangular markers the
PE routes.

The dashed lines indicate the fact that aircraft will be under approach con-
trol for that distance. For instance, an aircraft inbound from JHB will pass
directly over the two waypoints (Nokox and Wolseley) illustrated by the blue
markers; after passing over the second waypoint the control tower of the air-
port will assign the incoming aircraft a specific runway and approach path.
Similarly, outbound aircraft will be given instructions as on how to reach
their first waypoint. The path taken by aircraft over distance indicated by
the dashed line will vary with every aircraft approach and departure.

Effective Radiated Power of the Transmitters

As was mentioned in Section 2.3.1, the mountainous terrain - clearly visible
in Figures 2.7 and 2.8 - has led to the necessity for multiple transmitters lo-
cated in a fashion to cover the greatest area. This may be advantageous for
a multistatic or netted radar configuration, however, it has the consequence
that the signals emitted from these transmitter are of relatively lower power
than those that would have been emitted across regions of more level terrain.
The transmit powers are lowered, in this case, in order to avoid mutual in-
terference between closely spaced stations operating on the same frequency
[6].

Table 2.3 shows some parameters of the 6 potential illuminators of opportu-
nity identified. These 6 transmitters possess the highest effective radiated
power (ERP) out of all the transmitters in the Cape region and are relatively
similar in terms of ERP level, with the possible exception of the Tygerberg

transmitter.

Antenna Beamwidth

With the ERP known, the interaction between the factors antenna beamwidth
and flight paths of commercial aircraft is of interest. Since the focus of here is
on ATC, of particular interest is a transmitter that illuminates the airspace
around the airport as well as the various designated flight corridors.

The values for antenna beamwidth are given in Table 2.3 and illustrated with
the common flight routes in Figure 2.9.
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Figure 2.9: Beamwidth and transmitter power output for potential illumina-
tors of opportunity within the Western Cape.
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Table 2.3: Transmitter beamwidth, power and gain for potential illuminators
of opportunity.

Number | Transmitter | Power | Antenna ERP Antenna Beam
Name [dBm] | Gain [dBm] | [dBm] | Direction [°] | Width [°]
1 Constantiaberg 60 10 70 25 70
2 Ceres 57 16 73 25 65
3 Matjiesfontein 60 10 70 0 360
4 Piketberg 60 10 70 0 360
5 Tygerberg 57 4 61 0 360
6 Villiersdorp 60 10 70 0 360

Figure 2.9 (a) shows that in addition to being far away (Table 2.2), the Piket-
berg, Ceres and Matjiesfontein transmitters possess minimal coverage of the
major flight routes of interest. A good coverage of the PE flight routes as well
as a reasonable coverage of the JHB flight routes is shown for the Villiersdorp
transmitter.

An enlargement of the area around the receiver is given in Figure 2.9 (b).
This figure also illustrates the specified antenna beamwidths of the Constan-
tiaberg and Tygerberg transmitters. The Constantiaberg transmitter has a
directive beam which covers mostly inbound JHB air traffic. The Tygerberg
transmitter, however, with its omnidirectional radiation pattern, offers the

best coverage of the airspace surrounding the CPT INTL Airport.

Regardless of the airspace coverage, both transmitters are in close proximity
to the PCL receiver, which may be cause for concern in terms of direct path
interference. The detrimental effects caused by the DPI could potentially be
reduced by terrain obstructing the line-of-sight between the transmitter and
receiver and is dealt with next.

Line-of-Sight

The issue of line-of-sight relates back to the choice of transmitter (and re-
ceiver) location. By choosing a illuminating transmitter which is located
just over the horizon or behind elevated ground, a situation may be achieved
where the direct signal is somewhat reduced. This will reduce the detrimental
effects caused by the DPI, however, the direct signal must be strong enough
to be measured by the reference antenna for correlation purposes, where the
reference antenna is usually in close proximity with the target antenna array.
The propagation path of the echo signal should not be obstructed, namely the
signal paths from the transmitter to the target followed by the reflected signal
path from target to the receiver should line-of-sight as much as possible.

From the previous sections, Tygerberg and Villiersdorp transmitters offered
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the best coverage of the flight corridors and possessed good ERP values. The
terrain profiles from these two transmitters to the PCL receiver located at
UCT are given in Figure 2.10.

A significant difference in the terrain between the transmitter and receiver
for both cases is apparent. It is clearly seen that the Tygerberg transmitter
is in full view of the PCL receiver as well as in close proximity (15.6 km). To
suppress DPI from the Tygerberg transmitter would require a very deep null
in the direction of that transmitter.

200 — — — — — — — — — — — — — — — —

w4+— — — — — — — — — — — — — — — —

Height {m)

(a)

Height [m)

100
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Figure 2.10: Terrain profiles between the receiver site at UCT and the (a)
Tygerberg and (b) Villiersdorp transmitters.

In contrast, the Villiersdorp transmitter is not line-of-sight with the PCL re-
ceiver and is also a further distance of 96.8 km. Using this transmitter as
illuminator of opportunity could offer some advantageous characteristics in

terms of DPI reduction using obstructing terrain.

Geometry for bistatic Doppler

Knowing the flight routes taken by the aircraft allows for an estimation of
the expected Doppler. Doppler is an effect seen on the signal itself, but is dis-
cussed here since it is inherently dependent on the choice of the illuminating
transmitter and the resulting PCL system geometry.
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Here, the Doppler expected as a result of using the Villiersdorp and Tygerberg
transmitters for an aircraft flying the JHB and PE routes is investigated. The
Doppler shift of such an aircraft is governed by,

fa= % (cos 6 + cos bs) (2.6)

where v is the velocity, A is the signal wavelength and the angles 6, and 6, are
shown in Figure 2.11 as derived from [7].

Receiver

Transmitter
Figure 2.11: Geometry of Bistatic Doppler.

Figures 2.12 and 2.13 show the estimated Doppler, normalised by the factor
(v/A), of flights en route with Johannesburg and Port Elizabeth respectively.
It is apparent from these figures that the Tygerberg transmitter exhibits the
best Doppler properties over all flight routes.
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Figure 2.12: Normalised Doppler estimation for (a) inbound and (b) outbound
flights en route with JHB.

The Villiersdorp transmitter falls short as the aircraft near the airport. For
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aircraft travelling further away from the airport, however, the expected Doppler
as a result from using the Villiersdorp transmitter becomes comparable with
that of the Tygerberg transmitter. An example of this can be seen in Figure
2.13 (a), where the Doppler of an aircraft inbound from PE is almost identi-
cal for both the Tygerberg and Villiersdorp transmitters up until the Greyton
Waypoint. Thereafter, as the aircraft nears the airport the the Villiersdorp
Doppler falls to zero - a consequence of flying near and parallel to the bistatic
baseline.
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Figure 2.13: Normalised Doppler estimation for (a) inbound and (b) outbound
flights en route with PE.

As was mentioned above, aircraft are under approach control near the airport.
This will vary the flight paths and subsequently the estimated Doppler of
aircraft in close vicinity to the airport. Namely, this has the consequence
that the Doppler due to the Villiersdorp transmitter may indeed improve for
specific aircraft approach and departure paths.

2.4 Expected Signal Strength

In the preceding section the Tygerberg and Villiersdorp transmitters were
identified as potential illuminators of opportunity for a PCL receiver located
at UCT. In this section the expected signal strengths of two FM radio stations,
one for each transmitter, are investigated. This will be done to illustrate the
significant effect the environment - especially terrain - has on the received
signal strength and in so doing, reinforce the requirement for AREPS and

APM to accurately model realistic propagation loss.
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Parameters specific to each transmitter are listed in Table 2.4.

Table 2.4: Parameters of the Villiersdorp and Tygerberg transmitters.

Transmitter Transmitter
Parameters Tygerberg | Villiersdorp
ERP [dBm] 61 70
Frequency f, [MHz] 88.2 96.5
Radio Transmission Name | 5FM Radio | FM Radio
Polarisation Vertical Vertical
Distance to Receiver R [km] 15.6 96.8

These parameters together with the receiver gain, G.,, can be used to predict
the signal strength received under free space conditions with the use of the
well-know Friis equation (2.7). In addition, by replacing the last term of equa-
tion (2.7) with the propagation loss computed by AREPS, the realistic signal
strength received at UCT can be determined.

2

P.(dB) = G,(dB) + P,(dB) + 101og (i—ﬂ) — 10log (47 R?) (2.7

Table 2.5 shows the different values of the signal strength received at UCT
for a receiver gain, GG, = 8dB. In addition to the propagation loss and signal
strength obtained for the free space and simulated cases shown in the table
is the signal strength physically measured at UCT.

Table 2.5: Signal strength expected and received at UCT from the Tygerberg
and Villiersdorp transmitters.

Transmitter Free Space Simulated (AREPS) Measured
Name Propagation | Signal Propagation Signal Signal
Loss Strength Loss Strength | Strength
[dB] [dBm] [dB] [dBm] [dBm]
Tygerberg 94.9 -26.2 91.9 -23.3 -33.7
Villiersdorp 110.7 -33.9 143.1 -66.3 -71.5

First we note the difference in the propagation loss for the free space and
simulated cases, where this difference is known as propagation factor as dis-
cussed in Section 2.2 and given in equation (2.2). For the Tygerberg trans-
mitter, the propagation factor is +3 dB and for the Villiersdorp this factor is
—32.4dB. This difference in propagation factor is significant and illustrates
major effect that the environment can have on a propagating signal. In the
case of the Villiersdorp transmitter the large 32.4 dB discrepancy is due to the
severe obstruction of LOS illustrated in Figure 2.10 (b).

A discrepancy is apparent between the simulated and measured signal strengths
for both transmitters. In both cases the measured signal is less than the
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expected due to simulation. The discrepancy is 5.2dB for Villiersdorp and
10.4dB for Tygerberg. The discrepancy can in part be attributed to system
losses incurred in the measurement equipment (antenna, transmission line
and connectors). These losses were not factored into equation (2.7). The dif-
ferences between the two discrepancies points towards a small variable error
in the AREPS model and is expected since the AREPS model is itself based
on model of terrain and atmosphere.

However, this error is deemed acceptable since it is small compared to the sig-
nificant variation of the propagation factor, modelled by AREPS, for changing
environments. This is clearly seen for the case of the Tygerberg transmitter
and justifies the use of AREPS as a EM wave propagation modelling tool in
this dissertation. In addition, the advantage of using AREPS propagation loss
over that of free space propagation loss is clear.

2.5 Conclusion

This chapter introduced and discussed a variety of environmental effects.
Of the effects discussed, the effects of multipath, diffraction and shadowing,
caused by varying terrain, on a propagating signal were identified as the most

prominent.

A means to model these effects, with the use of the tools AREPS and APM,
was presented. These tools will be used in later chapters to compute realistic
propagation loss for the use within proposed performance prediction method.

After the discussion of detrimental environmental effects, the broadcast trans-
mitters and their associated signals were investigated. Two broadcast trans-
mitters exhibited good characteristics for use as illuminators of opportunity
for the case where the PCL receiver is located at UCT. Out of these two trans-
mitters, the Villiersdorp transmitter presented the best-case characteristics.
It’s location, which is out of line-of-sight due to some mountainous terrain,
provided additional attenuation of the direct signal and thus additional sup-
pression of the DPI. The signal is, however, still at a measurable level for the
reference antenna. Further suppression of DPI in the target antenna could
be achieved by steering a null in the direction of the transmitter.

After the investigation completed in this chapter, the Villiersdorp transmitter
will be used to introduce the improved method of performance prediction pro-
posed in Chapter 3. The method is designed to provide the user with a means
to compare the effectiveness of potential illuminators of opportunity with rel-
ative speed and ease, by essentially automating the process undergone in this
chapter.
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Chapter 3

Bistatic PCL System
Performance Prediction Method

In this chapter a method' of predicting bistatic PCL performance, while ac-
counting for environmental effects, is presented. The performance prediction,
in the form of spatial signal-to-noise ratio (SNR), signal-to-interference ratio
(SIR) and also signal-to-noise-plus-interference ratio (SNIR) coverage maps,
provide a visual means for determining radar detection range and required
dynamic range of the receiver. Using this method, expected coverage at dif-
ferent altitudes with specified transmitter and receiver properties is deter-
mined and compared with the conventional prediction method calculated in
free space, as described in Section 1.1.3. The method, which is essentially
an extension to the work of Griffiths and Baker [22], provides the user with
a means to compare the coverage of potential illuminators of opportunity
quickly and easily.

The coverage maps produced here are based on an interpolation of propaga-
tion loss data generated by APM and AREPS. Namely, realistic propagation
loss is utilised to predict the loss along any path from a transmitter to a tar-
get and onwards to a receiver. As discussed in the Section 2.1 and 2.2 this is
achieved by taking into account the propagation factor, ', which is a quan-
tity that commonly contains the effects of refraction, diffraction, multipath as
well as atmospheric attenuation.

To model the loss from a moving target to a receiver is difficult, since radar
coverage prediction requires this to be done for all possible target positions,
to the receiver. By appealing to theorem of reciprocity, the target to receiver
loss is modelled in the reverse direction. It is thus possible to map the two
way loss to each pixel of the area being assessed in one set of calculations,
the results of which can be held as a lookup table for simulation or coverage

assessment. The method’s accuracy will degrade slightly in the case of targets

!See Appendix B for detailed explanation on how to perform performance predictions.
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lying in shadow regions subject to knife-edge diffraction.

This chapter begins by discussing the SNR, SIR and SNIR equations, derived
from the well-known bistatic radar equation, for the purpose of coverage pre-
diction. This is followed by a discussion of a conventional model of bistatic
coverage, the ovals of Cassini. The Villiersdorp transmitter will be used, here,
as a case study.

The proposed method of determining expected bistatic PCL radar coverage,
while accounting for environmental effects, is then developed. Once again, the
Villiersdorp transmitter will be used as a case study to illustrate the method.
Observations are made and differences between the coverage maps produced
by conventional methods and those produced by processing AREPS data are

then discussed. Finally, some conclusion are drawn.

3.1 Representation of Bistatic Coverage

The detection range and required dynamic range of a bistatic radar can be
represented by the spatial SNR, SIR and SNIR coverage maps.

The work here is based on the bistatic radar configuration illustrated in Fig-
ure 3.1. The three propagation paths; transmitter-to-receiver, transmitter-to-
target and target-to-receiver are represented by the letters a, b and c respec-
tively and will be used as subscripts to describe path-specific variables.

Broadcast
b Signal Broadcast
." < Transmitter

Echo
Signal
9 ¢ Reference

DPJ
a
Y Y Signal
Antenna Reference
Array Antenna
|

Receiver System

Figure 3.1: Bistatic Radar Configuration

As shown in Chapter 1, radar detection performance is best described by the
probability of detection, P;, and the probability of false alarm, P;,. It can
be shown that these two quantities define a minimum signal-to-noise ratio
(SNR) [8]. Consequently, a more realistic detection range is determined by
inserting the predicted propagation loss into the bistatic SNR radar equation.
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The bistatic SNR equation is derived from the bistatic radar equation [7] and

is given as,
SNR — Pr _ PTGTbGRc/\zgo'B (FchQ)2
N, kT,B,, (47)° (RyR.)

(3.1)

Furthermore, one of the greatest limitations to a passive bistatic radar and
especially PCL, is the interference of the direct signal (DPI) in the detection
channel as discussed in Section 2.3.1 and 2.3.2. Plotting spatial maps of SIR
and SNIR provides an effective means of determining the required dynamic

range of ones receiver system. The bistatic SIR equation is represented by,

Pr  PrGrGreAiop (Fch)2 (47TRa)2 GrvGRreop (Fch)2 R?
SIR —_ T = 3 2 2 172 = 2
PD (47T) (RbRC) PTGTaGRa)\ Fa GTaGRa4’/TFaQ (RbRC)
(8.2)

The SNIR equation describes the power of the target echo signal received over
the sum of the noise and interference and is given by the equation,

2 2
SNIR — Pr _ PrGryGreXop (B F,) (3.3)

(No+Po)  (4m)® (RyR.)? (KB, + Prenei®li )

Equations (3.1) through (3.3) share the common variables,

Pr = Bistatic power of target echo measured at the receiver
Ny = White Gaussian noise

Pp = Power of direct signal measured at the receiver

Pr = Transmitter power output

R., R, , R. = Range along paths a, b and c respectively
F,, F,, F. = Propagation factor along paths a, b and c respectively

Gra, Gy = Transmit antenna gain along paths a and b respectively
Gra, GrRe = Receiver antenna gain along paths a and ¢ respectively
op = Bistatic radar target cross section (RCS)
Ts = System noise temperature
B, = Noise bandwidth
k = Boltzmann’s constant (1.38 x 10723 //k)

A = Wavelength.
It is evident that the values of the gains G, the propagation factors £’ and the
ranges R corresponding to both path b and path ¢ vary with target position.

Variations in target radar cross section as a function of angle of incidence and
re-radiation are not considered in this work. Not only is there not very much
data available in the way of multistatic radar cross section measurements,
the value is very dependent on exact knowledge of the target aspect angle.
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3.2 Conventional Coverage Prediction Model

Conventional performance predictions can be made by using the equations
(3.1) through (3.3) and disregarding - setting to unity - the propagation fac-
tors, F. In the simple case, where omnidirectional antennas are employed at
both the transmitter and receiver, the resulting coverage map will be in form
of ovals of Cassini. These conventional predictions, based on computations
done in free space result in ovals of Cassini because, in this case, the equations
have the mathematical form K/ (R,R.)*, where K is the variable representing
the remaining variables of constant value for each equation. Namely,

PTGTbGRc/\zaB
= (3.4)
SN LB, (4r)?
GTbGRcUBR2
Kop= ——2—1¢"2 a 3.5
SIR CraGdr (3.5)
PrGryGre)\io
Ksnir = . T RP GBGR v (3.6)
TS Ta a
(471’) <l€Tan + W)

The model can be improved by adding the antenna patterns to the calculation,
without too much difficulty. This section is very similar to the work done by
Griffiths, Baker and Howland [22, 2, 1], reviewed in Section 1.1.3, with the
Figures 1.3 and 1.4 illustrating their work.

As a case study, real transmitter and receiver parameters are applied here, to
represent a hypothetical PCL system. The transmitter used, is the Villiers-
dorp transmitter, discussed in the previous chapter. Its important parameters
are summarised in Table 3.1%,

Table 3.1: Parameters of the Villiersdorp transmitter.

Transmitter Power Output [dBm)] 60
Frequency [MHz] 96.5
Radio transmission name KFM

Polarisation Vertical

Transmit antenna 3 dB beamwidth [°] 360

Transmit antenna gain [dB] 10
Distance from UCT receiver|km] 96.8
Bearing from UCT receiver [°| 89.6

The receiver, located at UCT, has a hypothetical omnidirectional receive an-
tenna with a gain of 5dB in the azimuth plane over an isotropic antenna.
This would represent a directive dipole (or vertical collinear array of dipoles)
creating the classic do-nut radiation pattern focusing its energy towards the

2See Appendix C.1.1 and Table C.1 for the complete set of configuration parameters used.
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horizon. This is a simplified version of the antenna system that is planned,
and discussed further in Chapter 4. In this case, both the transmit and
receive antennas are omnidirectional, resulting in G, = Gr. = 5dB and
Gr, = Gpy, = 10dB.

The bistatic RCS, o, is considered isotropic and is set to 10m? to represent a
large commercial aircraft and the propagation factor, ', is set to unity. The
noise bandwidth, B,, is set to 1 Hz to simulate an integration time of 1 second,
which is based in turn on equation (2.4).

The factor kT is 4.002 x 10~ W/Hz, where T, is the sum of the antenna noise
temperature and the equivalent noise temperature of the receiver, namely
T,=1T,+1T.. Here, T, = 290 K and T, = 28710 K, where T, is the noise temper-
ature of a receiver with a noise figure of F,, = 20dB.

Applying these values to equations (3.1) through (3.3) it becomes apparent
that results from the SIR and SNIR equations are almost identical, namely

§

SNIR « SIR
Pr  _ Pg

—_— = = 3.7
(No + Pp) Pp 8.7)

Calculating the values Ny, = 4.002 x 107" W and Pp = 2.054 x 107" W it is
clear that Ny <« Pp. In this case, the white Gaussian noise, Ny, is 12 orders
of magnitude smaller than Pp, meaning it is —120 dB below P, and thus has

a negligible effect. This illustrates the severe effect that the direct signal has
on PCL.

For the remainder of this dissertation, only SNR and SIR coverage maps will
be considered. SIR coverage maps are chosen over SNIR maps, as it is felt
that the SNIR maps in their current form do not provide any additional infor-

mation.

The resulting ovals of Cassini, presented in Figures 3.2 and 3.3, show the
predicted performance in terms of spatial SNR and SIR coverage maps for
the hypothetical PCL system. The UTM geographical projection used here,
allows the spatial coverage maps, also in Cartesian form, to be overlayed onto
a metric UTM grid.

Figure 3.2 shows a spatial coverage map in terms of SNR. For a required SNR
of 15 dB (see Section 1.1.3), this method predicts a detection range of up to
250 km as can be seen in the figure, which in the light of existing systems is
somewhat optimistic.

Figure 3.3 shows a spatial coverage map of SIR and illustrates quite effec-
tively, that for a reasonable detection range, the echo signal can be up to 90

to 100 dB below the direct signal. This is consistent with predictions done by
Wan and Howland [24, 2].
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Figure 3.2: Conventional coverage prediction in terms of SNR in free space
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It is evident that the coverage shown here is under ideal environmental cir-
cumstances, which does not mean it provides ideal results. The assumption
that the propagation loss occurs in free space is a major limitation of the ac-
curacy of this model. This particular limitation can be addressed by including
the propagation factor, /', which accounts for the effects of the terrain and

atmosphere, in the coverage computations.

3.3 Improved Coverage Prediction Model

An improved model for producing bistatic spatial SNR and SIR maps of pre-
dicted system performance by processing and interpolating realistic propaga-
tion loss data captured from APM and AREPS is presented here. This loss
data includes the terrain and atmospheric effects, represented by the propa-
gation factors, /', in equations (3.1) and (3.2).

3.3.1 Spatial Data Capture and Interpolation

In the general case, AREPS creates a height versus range propagation loss
data set for a desired azimuth bearing [27] from a specific site. The propaga-
tion loss term that is extracted from this data set is solely dependent on the
free-space propagation loss, 47 R?, and the propagation factor, 2, and is given
by,

A R?
LPL - F2 (38)

The propagation loss data extracted from AREPS is essentially 3D polar data,
(r,¢,h). A cubic interpolation on this polar data, at an altitude of interest (h),
is performed so as to achieve a regular grid of propagation loss data associ-
ated with one specific site, as illustrated in Figure 3.4. This interpolation is
necessary so that propagation loss data from different sites can be combined
over a common Cartesian grid. The combination of propagation loss data is
important for the computation of the SNR and SIR coverage maps. Lastly,
the resulting coverage maps, being in grid form, can easily be overlayed on a
UTM grid as was done in Section 3.2.

More specifically, SNR coverage maps require the combination of the Carte-

sian propagation loss data for the two variable, target dependent paths (transmitter-
to-target and target-to-receiver). In addition to the combined propagation loss

along these two paths, SIR coverage maps must also factor in the propaga-

tion loss data for the unvarying transmitter-to-receiver path of a particular
bistatic PCL system.
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Figure 3.4: Illustration of Interpolation procedure at one particular height, h.

The procedure of capturing and interpolating the propagation loss data is
best described by means of an example and thus the case study, involving
the Villiersdorp transmitter as the illuminator of opportunity, introduced in
Section 3.2, is also applied here.

Transmitter-to-Receiver Path (Path «)

Here the propagation loss as described by equation (3.8) along the path «a is
only necessary for the computation SIR coverage maps and resolved directly.
Namely, Lp;, at the exact position of receiver is found. In addition, the trans-
mitter and receiver gains are included for the path under consideration. The
complete transmitter-to-receiver path loss is governed by,

47 R?

“~ F2GnGra (3.9)

This value does not vary with target position. Namely, L, is a single, constant

value for particular transmitter and receiver locations.

Transmitter-to-Target Path (Path 0)

For this path, AREPS is used to calculate the propagation loss every 5° from
0° — 355° (72 bearings) for a range up to 300 km and an altitude up to 6000 m
above mean sea level.

At this point, the altitude of interest is specified to be 1600 m to investigate
the possible coverage of low flying aircraft and the effect of the terrain. Matlab
is used to extract the AREPS propagation loss data represented by equation
(3.8) for each bearing at the specified altitude.

The propagation loss data in this form is illustrated in Fig. 3.5 and shows
72 polar propagation loss data sets, one set for each bearing increment. Each
data set contains propagation loss data at a finite number of range steps.
The data in this form - before interpolation - can be likened to the leftmost
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Figure 3.5: Polar propagation loss [dB] for the Villiersdorp transmitter at
1600m.

illustration in Figure 3.4. Gaps in the data are an indication of mountainous
terrain at the specified altitude and range.

Every propagation loss data set is now weighted by the transmit antenna gain
at the relevant azimuth bearings. In this case, the transmit antenna gain,
Gy, 1s omnidirectional; thus the collective propagation loss data sets given
by Lp; are decreased by 10 dB. The result is a loss term which represents
the transmitter’s combined polar propagation loss and gain and is given by
Ly(dB) = Lpr(dB) — Gry(dB), where Ly, is the loss for the transmitter-to-target
path (path b).

Next, a cubic interpolation is performed on the transmitter’s combined polar
propagation loss and gain data. This interpolation employs the Delaunay
triangulation method and is done over a Cartesian grid encompassing the
region of interest. The result is a grid of propagation loss data representing
all possible transmitter-to-target paths within the region of interest. The loss
data and transmitter-to-target paths are governed by the equation,

47TR§

= 3.10
F2Gry (3.10)

b

The points of the Cartesian grid are referenced to a UTM grid at was done in
Section 3.2.
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Target-to-Receiver (Path ¢)

Here it is assumed that the paths of propagation loss between the target and
receiver are reciprocal. This assumption, which is fair for high altitudes, al-
lows the receiver to be treated as a transmitter within AREPS. This assump-
tion is currently necessary, since it is not computationally feasible to simulate
the propagation loss from every possible target position to the receiver. Thus,
to determine the target-to-receiver propagation loss, a transmitter is placed
at the receiver location and using the same procedure as presented above, the
propagation loss is computed at 5° increments for the entire azimuth.

The propagation loss data sets are now weighted by the omnidirectional re-
ceiver antenna pattern. This results in a target-to-receiver path loss given by
L.(dB) = Lpr(dB) — Gg.(dB).

The complete target-to-receiver path loss data is then interpolated over the
same regular Cartesian grid as before. In this case the points on the grid are
governed by,

4 R?

L, =
FgGRc

(3.11)

Round-trip propagation loss (Path ic)

Both propagation loss grids, represented by equations (3.10) and (3.11), can
be combined to form,

(47)% (RyR.)?

Lye = Ly L. = D)
(Fch) GTbGRc

(3.12)

This can be done since both L, and L. have the same regular Cartesian grid.
This combination results in a grid where each point represents the round-trip
propagation loss L;. as well as the gains for the transmit and receive antennas
for a particular target position.

3.3.2 Computation of Bistatic Coverage Maps

Substituting the round-trip loss grid, L;., of equation (3.12) into equation (3.1)
gives,
P R P T)\20' B

SNR = —

== 3.13
N, kT B,(47)Ly. ( )

Setting the remaining variables to the values specified in Section 3.2 a spatial
SNR map is generated. This spatial SNR map is shown in Figure 3.6 and
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indicates possible detection range and coverage feasibility at an altitude of
1600 m.
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Figure 3.6: Spatial SNR map [dB] at 1600 m with omnidirectional receiver
pattern.

In the case of the SIR the combined loss of equation (3.12) and the direct path
loss of (3.9) are of interest. The SIR equation (3.3) can be represented as,

P L
SIR = —& = 2B

Py~ L. (3.14)

As in the case of SNR, a spatial SIR map can be generated using equation
(3.14). Figure 3.7 shows a SIR map for the parameters stated in Section 3.2.
In general, Figures 3.2, 3.3, 3.6 and 3.7 use the same bistatic configuration

parameters’.

3.3.3 Observations

Looking at Figure 3.6 and Figure 3.2, it is evident that the simulated pre-
dicted coverage is much reduced compared to the conventional case. At an
altitude of 1600 m above sea level, a detection range of around 75 km is pre-
dicted, a reduction of around 175 km from the conventional case. The re-
duction is not unexpected, yet important to note is the significant effect that
environmental factors have on the bistatic SNR radar equation and radar de-

tection range.

3See Appendix C.1.1 and Table C.1 for the complete set of configuration parameters used.
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Figure 3.8: Spatial SNR map [dB] at 5000 m.
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Figure 3.8 illustrates simulated predicted coverage of up to 150 km for an al-
titude of 5000 m. This shows, as expected, better coverage at higher altitudes.
At higher altitudes the effects of the terrain on the propagation factor have
lessened and the AREPS generated propagation loss data tends towards free-
space-like propagation loss. Consequently, the coverage map can be likened
to ovals of Cassini.

A significant difference is also observed between Figures 3.3 and 3.7. With ref-
erence to a commonly accepted SIR of —60 dB the maximum coverage achieved
according to the conventional prediction method is less than 20 km surround-
ing the receiver and the transmitter as seen in Figure 3.3. With the addition
of the environmental effects, the performance of the PCL system is predicted
to improve. The improvement of required dynamic range is about 25 - 30
dB, consistent with the added propagation loss expected along the path of the
direct signal (Table 2.5). As seen in Figure 3.7 the coverage in some cases
extends as far as 100 km out from the receiver.

It is evident from equation (3.14) that to improve coverage described by the
SIR, as shown in Figure 3.7, one must increase the direct path loss L,. A
common method of further increasing the direct path loss is to decrease the
target antenna gain, Gp,, in the direction of the transmitter by means of null
forming.

3.4 Conclusions

This chapter introduced an improved method of generating SNR, SIR and
SNIR coverage maps representing possible detection range and required re-
ceiver system dynamic range. This was done using APM and AREPS to
compute realistic propagation loss, which incorporated the propagation fac-
tor. Significant differences between the conventional coverage maps - ovals of
Cassini - and the coverage maps based on the AREPS propagation loss were
presented. These differences emphasised the importance of the propagation
factors, F', which take into account the effects of the terrain and atmosphere.

The SNR coverage maps showed an expected coverage, for given environment
and system parameters, of around 75 km and 150 km at an altitude of 1600 m
and 5000 m, respectively. These realistic detection ranges, were as expected,
much less than the 250 km detection range predicted using the conventional
model.

The SIR (and SNIR) coverage maps indicated the required dynamic range
within a certain coverage region for a specific bistatic radar configuration. An
improvement, of around 25 dB, in the SIR coverage maps and subsequently

4See Appendix C.1.2 and Table C.1 for the complete set of configuration parameters used.
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the required dynamic range was seen by the increase of direct path loss re-
sulting from the terrain and atmosphere effects. The required dynamic range
can be further improved by introducing a receiver pattern null in the direction
of the transmitter and will be investigated in Chapter 4.

This method can be used to compare various arrangements of receivers and
transmitters in any bistatic configuration and will aid in the choice of opti-
mum non-cooperative transmitter and receiver location.

A current shortcoming of this method is the assumption of reciprocity, which
is a simplification, the effects of which must be investigated further. In addi-
tion, the RCS of the target is assumed to be isotropic and constant. In reality
the bistatic RCS of the target is of interest, which requires knowledge of 3D
shape of the target and the angles at which the EM waves are incident and
reflected.

Despite this, the method presented here offers improved performance predic-
tion capability over the conventional prediction method. Using this method,
various configurations of receivers and illuminating transmitters can be tested,
easily and quickly.
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Chapter 4

Target Antenna Pattern
Synthesis and Coverage
Improvement

As concluded in Chapter 3, a high power direct path signal has an adverse
effect on the performance of a PCL radar. By suppressing the direct path
signal in a target antenna pattern null the performance and subsequent cov-
erage of the PCL radar can be improved and forms the subject of this chap-
ter. Here, the modified coverage of expected detection range and required
dynamic range in terms of SNR and SIR resulting from the target antenna
pattern synthesis is presented. In particular, the Schelkunoff method is used
to synthesise a pattern null in the direction of the illuminating transmitter
to suppress the DPI in the target antenna of a PCL receiver. The case study
introduced in the previous chapter is carried through here.

The chapter begins by listing necessary requirements for target antenna ar-
ray, such as direction of the null and the size of the array. This is followed
by a discussion of the folded dipole, intended for the use as the elements of
the target antenna array. Here, the various parameters of the antenna are
characterised.

The sophisticated antenna and EM modelling tool, FEKO, based on the tech-
nique of Method of Moments (MoM), is used in this chapter to simulate the
folded dipole element and later the target antenna array. The name, FEKO,
is derived from a German acronym which can be translated as "Field Com-
putation for Objects of Arbitrary Shape". The FEKO solver is based on the
Method of Moments, which it uses to calculate Maxwell’s equations.

Next, the antenna pattern synthesis technique, the Schelkunoff Unit-Circle
Method, is introduced and reviewed. With reference to the requirements,
the target antenna array is designed using this technique and simulated in
FEKO. The resulting array is investigated, with a particular focus on the sub-
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sequent azimuth radiation pattern.

Thereafter, the synthesised pattern, with a null in the direction of the trans-
mitter, is applied to the performance prediction method introduced in Chapter
3. The consequent effect on the coverage of the PCL system is presented and
discussed. Finally, conclusions are drawn.

4.1 Requirements

The core requirement is to reduce the direct path signal, the DPI, received
in the target antenna. This can be done by means of an antenna array and
null formation techniques. The Villiersdorp transmitter, is used here as the

illuminating transmitter. Requirements for the target antenna are:

e Reduce DPI by means of antenna pattern null in the direction of Villiers-
dorp transmitter, which is at bearing of 89.6° (referenced to True North),
while providing reasonable gain in the direction of existing flight paths.

e The antenna array must be linear and less than 5 m in length. This re-
quirement is a result of limited space on the roof of the Menzies building
at UCT coupled with the large wavelengths at FM frequencies. In the
case of the Villiersdorp transmitter, the KFM radio station transmits at
96.5 MHz which translates to A = 3.11 m.

e The antenna array must be low-cost and COTS where possible.

4.2 Elements of the Antenna Array

The antenna elements used for the array are folded dipoles, commercially
available and manufactured by SpaceTV"'. The folded dipole is also convenient
as it is structurally more stable and more broadband [4] than the simple half-
wave dipole. A model of the folded dipole, with the antenna port indicated as
the red segment, is shown in Figure 4.1.

The simulated real and imaginary input impedance at the terminals of this
antenna for all FM frequencies is shown in Figure 4.2. The input impedance
of a folded dipole is usually in the order of four times larger than that of a
simple linear dipole of similar dimensions (in the order of 7;, ~ 73 + j42.5Q)
[4], a property that can be seen in the figure.

The input impedance for the Villiersdorp transmission at 96.5 MHz is indi-
cated on both curves and is measured to be Z;, = 288.7 + j20.9Q. This in-
put impedance is relatively high compared to the characteristic impedance

lwww.spacetv.co.za, checked 6 February 2009.
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Figure 4.1: FEKO model of the folded dipole .

Zy = 75€) of the RG 6 transmission lines usually associated with this an-

tenna. Thus, a small matching network and balun, at the terminals of the

folded dipole is employed by the manufacturer SpaceTV to transform the in-

put impedance to a nominal 75 (2 value.
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Figure 4.2: Simulated input impedance of the folded dipole.

For the ideal case, where the dipole is conjugately matched at 96.5 MHz to

the transmission line and receiver system, maximum power can be received
at that frequency. The simulated bandwidth of the folded dipole, under this
condition can be seen in Figure 4.2. The bandwidth, measured as a reduction
of 10 dB on a |S1;| plot, is found to be 4.3 MHz (~ 4.5 % bandwidth), more or
less centred around the frequency of interest, 96.5 MHz.
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Figure 4.3: Simulated antenna bandwidth measured at -10 dB on a |S11| plot.

Finally, the antenna radiation pattern is given in Figure 4.4. A small devia-
tion in the antenna pattern is apparent and can be seen in Figure 4.4 (b). This
deviation has an amplitude of around 0.15 dB making the resulting radiation
pattern effectively omnidirectional in azimuth.
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Figure 4.4: Antenna radiation pattern of a single folded dipole.

As can be seen in Figure 4.4 (a) the deviation in the antenna pattern is be-
cause the one side of the folded dipole - the length of wire across from feed
port - acts as a reflector. Consequently, more power is radiated (reflected) in
the negative y-axis direction. This is further seen in Figure 4.4 (b) by noting
that the negative y-axis direction is at an azimuth angle of ¢ = 270°.

4.3 Target Antenna Pattern Synthesis

According to Balanis [4], antenna pattern synthesis can typically be classified
into three major categories, namely:
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1. Beam shaping
2. Narrow beam and low sidelobe forming

3. Null placement

The first category, beam shaping, requires that the antenna pattern exhibits
a desired distribution in the entire visible region. This can be achieved by the

Fourier and Woodward-Lawson methods discussed in Balanis [4].

The second category includes techniques that enable antenna patterns to be
produced that have very narrow beams and low sidelobes. These can, for
instance, be achieved by applying a binomial or Taylor [32] excitation distri-
bution to the antenna array.

Null placement, the third category, requires that antenna patterns possess
nulls in desired elevation # and azimuth ¢ directions. This can be achieved
by the Schelkunoff Unit-Circle Method, a technique covered in [4, 5], based
on Schelkunoff’s historical paper [33], and can be applied to a linear array of
antenna elements.

A focus of this dissertation is to suppress the DPI in the target channel inci-
dent from the illuminating transmitter. Since, in the general case, the trans-
mitters can be any direction relative to a potentially variable receiver location,
it is of particular use to be able to manipulate the position of nulls in an an-
tenna pattern. Thus, the Schelkunoff method will be the synthesis technique
used here and aims to satisfy the first requirement listed in Section 4.1.

4.3.1 Review of Schelkunoff’s Unit-Circle Method

Schelkunoff’s Unit-Circle method consists of the manipulation of the zeros
(nulls) of the array pattern to achieve a desired pattern for a linear array.
This representation can be used to describe any uniformly spaced array [5].
To synthesise a particular pattern, this method requires information on the
number of nulls and their locations [4] from which the number of elements
and their excitations are derived.

Suppose an array has M elements, arranged along the z-axis (Figure 4.5).
This arrangement of antennas would have an array factor (AF) governed by,

M M
AF = Y a, - Dibdecososingss) _ 3™ g cim1 (4.1)

m=1 m=1
where £ is the wavenumber and is equal to 27/5, d, is the inter-element spac-
ing, the angle of azimuth is given by ¢ and the progressive element phase shift
is given by . By limiting the investigation to the azimuth plane, 6 can be set
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Figure 4.5: Linear array geometry [4].

to 90° in which case sinf = 1. Considering that the array factor describes a
linear array along the z-axis, the array pattern will be symmetrical about the
xr-axis.

Now following Balanis [4] and letting

2=+ jy = eV = eihdacosdth) (4.2)
equation (4.1) can be rewritten as

M
AF = Z amz™ V= a1+ agz +azZ® + - +ay Mt 4.3)
m=1
This polynomial has (M — 1) roots and can be expressed as a product of (M — 1)
linear terms and in terms of magnitude as

AF =ay (2 —21) (2 —22) (2 — 23) -+ (2 — 2p-1) (4.4)

|AF| = |ay| |z — 21| |z — 20| |z — 23] - - |2 — 2N 1)) (4.5)

respectively. Where 21, 25, 25 ..., 2);_1 are the roots, which may be complex.

Looking again at equation (4.2), we note that |z| = 1 and thus z lies on a unit
circle. However, the position of 2z on the unit circle is determined by its phase
Y = kd,cos¢ + 5. The array pattern is symmetrical about the array axis as
seen in Figure 4.5, consequently limiting the azimuth angle ¢ to the range 0°
to 180°. As ¢ increases, ¢ decreases and z progresses in a clockwise rotation
along the unit circle as shown in Figure 4.6 [5]. The arc traced out by z, along
the unit circle, is referred to as the visible (realisable) region. The remaining
part of the unit-circle is known as the invisible region. Allowing v, — ¢, 2kd,
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to exceed 27 can cause more than one main beam (grating lobes) [5]. The
overall extent of the visible region can be controlled by the spacing between
the elements and its relative position on the unit circle by progressive phase
excitation of the elements [4].

Figure 4.6: Unit circle in the z-plane [5].

Looking again at equation (4.5) it is clear that |AF| is proportional to the
product of distances between z and each of the zeros (roots). If all the roots
are located in the visible region, then each one corresponds to a null in the
pattern of |AF| because as ¢ changes z = ¢/¥ changes and eventually passes
through each of the 2/, s [4].

Thus, it can be seen, that for a set of specified nulls in the azimuth plane
and for an array of given size, the zeros (roots) on the unit-circle can be ma-
nipulated to either reduce sidelobes or to place pattern nulls. Sidelobes are
reduced by moving the zeros on either side of it closer together. This has a
trade-off effect in that either the main-lobe beamwidth increases or the other
sidelobes rise [5].

Care must be taken when synthesising array using this method. By reducing
the spacing between elements, zeros can be shifted from invisible space to
visible space so as to narrow the beam and reduce sidelobes. As a consequence
large sidelobes are created in invisible space that represent energy storage in
the array. This stored energy reduces the bandwidth and efficiency of the
array [5].

4.3.2 Antenna Array Design and Simulation

The target antenna array, designed and simulated with FEKO, is comprised
of four folded dipole elements (discussed in Section 4.2) spaced 0.49 \ apart

and is shown in Figure 4.7. Spacing between elements is chosen slightly less
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than 0.5 )\ to avoid grating lobes but large enough so as to reduce mutual
coupling between the elements and energy stored in the array. A spacing of
0.49 ) for a carrier frequency of 96.5 MHz translates to a d, = 1.523 m spacing
between elements, which makes the array of four folded dipoles 4.570 m long
and puts it within the limit of the 5 m requirement.
Gain Tt
-

-B.7

-8.3

|
u

Figure 4.7: Receive antenna array, comprised of 4 folded dipole elements, with
radiation pattern of a uniform amplitude and phase distribution.

Figure 4.7 also depicts the broadside radiation pattern resulting for a uniform
amplitude and phase excitation distribution. Furthermore, the symmetry of
the antenna pattern about the array axis, resulting from the linear nature of
the array, is also apparent.

Figure 4.8 shows the orientation of antenna array, with element numbers,
in the azimuth plane with respect to the cardinal points. Here, the antenna
array patterns will be measured as angle of azimuth, ¢, with respect to the

array axis (z-axis). The array axis is measured as the angle v from South.

“‘True North
4 axis
3
E
W / -
2 /o
| ¥ A
X-axis
S

Figure 4.8: Orientation of antenna array in the azimuth plane.

Given the gain pattern of the array under a uniform distribution in addi-
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tion to the requirement for reduced gain in the direction of the Villiersdorp
transmitter and reasonable gain in the direction of existing flight paths, the
antenna array will be orientated such that peak of the broadside pattern is
in the direction of the flight route for aircraft inbound from JHB. This is done
since the formation of the null in the direction of the Villiersdorp transmitter
happens to be in the same direction as the flight routes associated with PE.

The chosen orientation can be seen in Figure 4.9, where inbound aircraft are
incident on an angle of ¢ = 90° measured anti-clockwise from the axis of the
array. The axis of the array itself will thus be orientated such that v = 40°.
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Figure 4.9: Normalised gain patterns of an array of folded dipoles (blue and
red) and point sources (green).

This arrangement would place the Villiersdorp transmitter at an angle of ¢ ~
50° from the antenna array axis. At this point, a signal from Villiersdorp
would be incident on a sidelobe (indicated in the figure by the top double
arrow) of the gain pattern, at a level of —13.9 dB.

Schelkunoff’s Unit-Circle method is used to specify nulls in such a way so as
to reduce the indicated sidelobe in the pattern of the uniform distribution, as
was explained in Section 4.3.1. The 4 antenna elements allow the specification
of 3 nulls, which are placed at ¢ equal to 30°, 40° and 50° to reduce the sidelobe.
These nulls correspond to roots of the Schelkunoff polynomial, equation (4.3).
Thus substituting the aforementioned values for k, d, and ¢ with a progressive
phase shift of § = 0° results in 3 roots:

7 = 1/£152.8° = —0.889 + j0.457
2o = 1/135.1° = —0.708 4 ;0.706
z3 = 1/113.4° = —0.397 + j0.918 (4.6)
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Substituting the complex representation of these roots (4.6) into equation
(4.4), with a,, set to unity, the complex coefficients a;,as ...ay of equation
(4.3) can be determined. These coefficients, being complex, provide the sought
amplitude and phase distribution of the array and are given in Table 4.1.

Table 4.1: Amplitude and phase distribution of an array using Schelkunoff’s
method.
| Number | Amplitude [V] | Amplitude [dB] | Phase [°]

Element 1 1 0.00 138.7
Element 2 2.88 9.19 92.5
Element 3 2.88 9.19 46.2
Element 4 1 0.00 0

Applying the resulting amplitudes and phases to an array of point sources,
results in a radiation pattern depicted in Figure 4.9 with the green curve. It
can be observed that the combination of the three nulls, in theory, produces
one wide null, as indicated by the bottom double arrow. This wide null is
positioned to cover the range of angles corresponding to sidelobe in question.

Applying the distribution, computed by Schelkunoff’s method, to the array of
folded dipoles (with v = 30°) results in a gain pattern illustrated by the red
curve in Figure 4.9. The reduction of the sidelobe apparent in the uniform
distribution can be clearly seen. The gain in the direction of Villiersdorp, is
reduced from —13.9 dB to —25.7, an improvement of 11.8 dB.

However, this improved effect is compromised by the reduction in the peak of
the main lobe by 3 dB in the direction of the JHB flight route and is seemingly
a trade-off alluded to in Section 4.3.1. This 3 dB compromise results in an
effective sidelobe level of —22.7 dB.

By orientating the array such that v = 30°, ¢ equals to 100° is in the direction
of the inbound aircraft from JHB and the direct signal is further reduced in
a null at ¢ = 60° of the array radiation pattern. In this case the direct signal
will be reduced down to —29.6 dB from the peak in the target antenna pattern,
as shown in Figure 4.10. This would result in a notable effective improvement
over the uniform distribution by 15.7 dB.
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Figure 4.10: Normalised gain pattern of an array of folded dipoles with exci-
tation distribution determined by Schelkunoff’s method.

4.4 Predicted Coverage with Synthesised Tar-
get Antenna Array Pattern

Figure 4.11 ? shows the the resulting spatial SNR map at an altitude of 1600
m after the application of the Schelkunoff synthesis method to the target an-
tenna and the consequent formation of the null in the direction of the Villiers-
dorp transmitter. Compared to Figure 3.6, the coverage shown here is much
improved in the direction of aircraft en route with JHB. A PCL system in this
configuration is predicted to achieve detection ranges of up to 100 km in the
sector of interest for an SNR of 15 dB.

The effect of the null can be seen by the reduced level of SNR expected in the
direction of the Villiersdorp transmitter. Furthermore, the coverage in the
southern direction is reduced, though for the application of the detection of
commercial aircraft en route with JHB this shortcoming is deemed acceptable.

Figure 4.12 ? shows an overall improvement of the coverage feasibility, in
terms of required dynamic range, compared to Figure 3.7, with no apparent
drawbacks. The coverage data presented here as a spatial SIR map showed
an improvement in the order of 30 dB in the JHB route direction. For an
commonly accepted SIR of —60 dB a coverage range in some cases up to 130
km can be expected.

In this case, there is no predicted decrease in performance in the southern

2See Appendix C.1.3 and Table C.1 for the complete set of configuration parameters used.
3See Appendix C.1.3 and Table C.1 for the complete set of configuration parameters used.
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Figure 4.11: Spatial SNR map [dB] at 1600m with synthesised receiver pat-
tern.
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Figure 4.12: Spatial SIR map [dB] at 1600m with synthesised receiver pat-
tern.
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direction as was seen for the SNR coverage. However, the required dynamic
range in this direction is not improved either, with the level of SIR remaining
relatively similar to that seen in Figure 3.7.

The spatial SNR coverage map at an altitude of 5000 m is shown in Figure
4.13 * . The figure also shows the flight paths discussed in Chapter 2. Here,
the predicted detection range is up to 150 km, a 50 km increase in detection
range from 1600 m (Figure 4.11). This further illustrates the significant effect
of the environment - especially terrain. Compared to Figure 3.8, the figure
shown here has a smaller possible detection region. This can, as before, be
attributed to the lack of coverage to the south.
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Figure 4.13: Spatial SNR map [dB] at 5000 m with synthesised receiver pat-
tern.

4.5 Conclusion

The Schelkunoff Unit-Circle Method was used in this chapter to illustrate the
coverage improvement that can be achieved by synthesising antenna patterns
and in particular by forming a target antenna pattern null in the direction of
the Villiersdorp transmitter.

The target antenna array and its elements were simulated and discussed with

the use of FEKO. The choice of folded dipoles as elements of the array was ad-
vantageous in that they are structurally stable and commercial available. The

4See Appendix C.1.4 and Table C.1 for the complete set of configuration parameters used.
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array, comprising of four folded dipole elements, was also simulated in FEKO.
Applying a Schelkunoff excitation distribution to the array saw an effective
sidelobe level in the direction of the Villiersdorp transmitter of -22.7 dB for
a normalised gain pattern. By changing the orientation of the array slightly
the direct signal can be reduce down to -29.7 dB from the peak of the main
lobe (in the direction of the JHB flight route). The Schelkunoff distribution
used here offered a 15.7 dB improvement, in terms of reduction of sidelobes,

over the uniform excitation distribution.

Utilising the azimuth pattern resulting from Schelkunoff distribution in the
performance prediction method presented in Chapter 3, showed improved cov-
erage in the sectors of interest as seen in Figures 4.11 through 4.13. The de-
crease of coverage in other sectors was deemed acceptable for the application
of the detection of aircraft in the direction of JHB. In general, the figures,
which show possible detection range and required dynamic range, suggest
that coverage in a sector of airspace can be improved significantly with the
application of antenna synthesis.
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Chapter 5
Antenna Array Implementation

In Chapter 4 an element excitation distribution was determined and applied
to a model of an array of folded dipoles within FEKO in order to null a strong
direct signal. In this chapter this excitation distribution is applied to real
folded dipole antenna elements representing the target antenna. This is done
for two reasons. Firstly, to verify the simulated pattern and to confirm that
the application of the Schelkunoff method used in the previous chapter yields
a physically realisable pattern. Secondly, to ascertain the predicted perfor-
mance in terms of detection range and dynamic range resulting from the mea-
sured pattern. The bistatic configuration investigated here is a continuation
of the case study dealt with in Chapter 3 and 4. The predicted performance
determined here is compared with that of the simulated case determined in
the previous chapter.

This chapter begins with a description of the components that make up the
target antenna array. Important characteristics of each of the components are
noted and their configuration making up the receiver system is also discussed.

Thereafter, aspects concerning the measurement of the antenna array are
dealt with. To begin with, a brief description of important measurement pre-
liminaries are given. Namely, the setup of equipment as well as the proposed
measurement procedure are described. Following the measurement proce-

dure the measured pattern is presented and observations made.

The bistatic radar detection range and dynamic range in terms of SNR and
SIR resulting from the measured pattern are determined and compared with
results of Chapter 4. Finally, conclusions are drawn.
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5.1 Antenna Array Setup

5.1.1 Target Antenna Array

Figure 5.1 illustrates the four channels leading from each antenna element
of the target antenna array into a combiner element. The signal captured
by each of the antenna elements is weighted and shifted in phase according
to the excitation distribution detailed in Table 4.1. Summing these altered
signals would yield a specific radiation pattern of the target antenna array as

was seen in Figure 4.9.

Target Antenna Array

NV V A4
0 B [

w w E\r‘ w
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~

2

l

Output

Figure 5.1: Target Antenna Array Receiver

5.1.2 Components'

The target antenna array as shown in Figure 5.1 was assembled from com-
mercial off-the-shelf products. The antenna elements were purchased from
SpaceTV and the transmission line, RG 6 cable, was sourced from Ellies®. In
terms of the weighting, Tee attenuators were built to manipulate the ampli-
tude distribution of the array. Lastly, the combiner element used to sum the
four channels was also sourced from Ellies. The entire receiver system has a

nominal impedance of 75 ).

The phase and attenuation of each of the four channels was measured with
an Agilent E5071B network analyser.

To begin with the S;; parameter of the four antennas was measured, the re-
sults of which can be seen in Figure 5.2. The antennas are specified to have a
nominal input impedance of 75 €). As can be seen in Figure 5.2 (a) the log-
magnitude responses of all four elements are well below the —10 dB level
for the entire FM band, suggesting good radiation characteristics within the

1See Appendix D for further details on components described in this section.
2www.ellies.co.za , checked 15 December 2008
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band. In addition, the phase response in (b) is relatively linear in the FM
band. No significant phase differences between the four antennas were ob-
served. Overall, the folded dipole elements provide good S;; characteristics.
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Figure 5.2: Measured log magnitude (a) and the phase (b) of the S;; parameter
at the input terminals of the folded dipole antennas.

Here, each channel is described as being comprised of transmission lines and
all other components found between an antenna port and a combiner port for
the particular channel.

Channels 1 and 4 contained an attenuator each, representing the weightings
w; and w, in Figure 5.1. Namely, instead of amplifying the amplitude in
channels 2 and 3 as suggested in Table 4.1 the signal amplitude in channels
1 and 4 is attenuated. Subsequently, weightings w, and w; are kept at unity.
Tee attenuators were built and added to channels 1 and 4 for the purpose of

applying the amplitude distribution to the target array.

The relative phase shift between channels indicated in Figure 5.1 as the com-
ponents ¢, through ¢, was achieved by the addition of varying lengths of
transmission lines.

After assembling all the channels, the S,; of each channel, including all the
aforementioned components, was measured using the network analyser. Of
interest was the relative attenuation and phase shift between each channel.
The final values recorded can be seen in Table 5.1 with the phase distribution
normalised to channel 4.

Lastly, the combiner sourced from Ellies was characterised. Table 5.2 sum-
marises the levels of insertion loss and isolation measured at 96.5 MHz, which
are mostly consistent throughout the entire FM band (Appendix D.4). The
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Table 5.1: Relative attenuation and phase shift measured between receiver
channels. Phase distribution is referenced to channel 4. Discrepancy between
measured and calculated (Table 4.1) is shown in the final two columns.

Measured Discrepancy
Channel | Relative Relative Phase | Amplitude
Number | Phase [°] | Amplitude [dB| [°] [dB]
1 138.4 -9.53 -0.3 -0.34
2 93.3 0 +0.8 0
3 47.3 -0.02 +1.1 - 0.02
4 0 -9.33 0 -0.14

overall characteristics of the combiner are good with the insertion loss con-
sistent over all input ports and only 1 dB higher than the theoretical 6 dB
insertion loss for an ideal passive 4 port combiner. In addition, the isolation
between input ports is good averaging around 27.5 dB.

Table 5.2: Combiner characteristics at 96.5 MHz.
Insertion Loss [dB] Isolation [dB]
S-1 \ S-2 \ S-3 \ S-4 1-2 \ 1-3 \ 1-4 \ 2-3 \ 2-4 \ 3-4
] 7.04 \ 7.08 \ 7.09 \ 7.06 H 25.89 \ 28.03 \ 28.38 \ 28.19 \ 28.69 \ 25.72 \

5.2 Array Pattern Measurement

5.2.1 Measurement Procedure

The aim of the measurement was to determine the azimuth radiation pattern
of the target antenna array. The Tygerberg transmitter was utilised for the
purpose of pattern measurement. This transmitter was the practical choice
for the purpose of the pattern measurement since it is a high power transmit-
ter and visible from the roof of Menzies with few physical obstructions.

In addition, the Tygerberg FM frequency used during the measurement is
that of Good Hope Radio and is at 96.2 MHz, 300 kHz below that of the Vil-
liersdorp transmitter frequency used throughout the case study. Namely, the
use of the Good Hope frequency here - with no change to the excitation dis-
tribution and structure of the array design in the previous chapter - has no
effect on the expected radiation pattern seen in Figure 4.10.

The target antenna array is rotated clockwise from an initial position in which
the positive = — axis, along array axis, is pointing in the direction of the Tyger-
berg transmitter as indicated in Figure 5.3. Rotating the array clockwise in
the direction of the red arrow essentially traces out the radiation pattern of
the array associated with the azimuth angle ¢ measured anti-clockwise from
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the positive © — axis. As discussed in the previous chapter, the linear nature
of the antenna array results in a symmetrical pattern around the array axis.
For this reason the measurement is performed over 180°.

Agerberg Tx

‘True North

J-axis ¢ 1 x-axis
Rotation
W =
4
S

Figure 5.3: Measurement procedure. The array is rotated clockwise in the
direction of the red arrow essentially tracing out the radiation pattern of the
array described by the black arrow associated with the azimuth angle ¢.

The output of the combiner as indicated in Figure 5.1 is fed through a match-
ing pad into a (Agilent E4407B) spectrum analyser. The matching pad matches
the 75 Q) receiver system output to the 50 Q input of the spectrum analyser
and has a specified 5.72 dB insertion loss in the FM band. The power of the
Good Hope Radio signal contained in the 100 kHz band, centred around 96.2
MHz, is then measured using the spectrum analyser over the range ¢ = 0°
to ¢ = 180° at every 10° step. Each measurement was done with a resolution
bandwidth of 1 kHz and due to the frequent variation of the radio signal, an
averaging factor of 100.

Figure 5.4 shows the physical measurement set up. As shown in the figure
the antenna array was rotated in a clockwise direction, once again illustrated
by the red arrow, around a central pivot point marked on the floor. Also seen
the figure are the folded antenna element numbers as well as the array axes,
where the positive y-axis is in the broadside direction of the array and the
positive x-axis is in the direction indicated away from the first element along
the axis of the array.

The picture of the array configuration indicated in Figure 5.4 is consistent
with that shown in Figure 5.3. The picture shows the array in its final po-
sitions. Namely, the array was rotated from its initial position as shown in
Figure 5.3 through 180° at 10° steps to the position shown in Figure 5.4.
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Figure 5.4: Measurement setup on the roof of the Menzies building. The
array axes, element numbers, rotation angle and azimuth angle consistent
with Figure 5.3 are also shown.

5.2.2 Results and Observations

Following the procedure detailed above, the power received by the array of
folded dipoles with a Schelkunoff excitation distribution was measured. To
illustrate the procedure, a particular measurement (at ¢ = 100°) is shown
in Figure 5.5. The band power of this particular signal was measured was
around -42.4 dBm.
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Figure 5.5: Measured power level (-42.4 dBm) in the 100 kHz bandwidth of
the 96.2 MHz, Good Hope Radio signal emitted from Tygerberg incident at
¢ = 100°.

As was seen in Figure 4.4 the pattern of the folded dipole has a mean value
of 2.15 dBi in the azimuth plane, similar to the value of the widely accepted

broadside gain of a half-wave dipole. The power measured by a single folded
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dipole, also with a resolution bandwidth of 1 kHz and an averaging factor of
100, of Tygerberg’s Good Hope Radio was -43.6 dBm. Due to the near omni-
directional nature of a single folded dipole, the signal power measured can be
said to be constant for all incident azimuth angles of ¢. Namely, rotating the
folded dipole in the azimuth plane sees no change to the measured power of
-43.6 dBm.

By referencing the measured power of the folded dipole target array to the
measured power of a single folded dipole the gain of the array is determined.
Namely, the gain of the array over an isotropic radiator can be expressed as,

Garr (ABi) = (Pyyy (dBm) — Py, (ABm)) + 2.15 (dBi) (5.1)

where G, is the gain of the target antenna array, P, and P, is the signal
power measured by the target antenna array and the single folded dipole re-
spectively. The factor 2.15 dBi is the mean gain of the folded dipole over an
isotropic radiator in the azimuth plane.

As an example, the measurement at ¢ = 100° would result in the gain of the
array, Go,, = (—42.4 — (—43.6)) 4+ 2.15 = 3.35 dBi.

The measured radiation pattern as well as the simulated pattern are shown in
Figure 5.6. The two patterns are in good agreement, however some deviations
are noted below.
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Figure 5.6: Comparison between measured and simulated azimuth pattern of
the target array.

Looking at Figure 5.6, point C in the figure indicates a discrepancy in the
gain of the main lobe of the pattern in the order of 5 - 7 dB. Another major
difference is seen at points A and D, which are much higher than predicted in
the FEKO simulation shown in the previous chapter.
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The discrepancies can be partially attributed to multipath effects as well as
to the insertion loss of the combiner, which were not factored into the sim-
ulation. The combiner would cause additional attenuation, or a decrease, in
the measured power and subsequently the absolute gain pattern. In terms
of multipath, the Menzies roof is positioned at the foot of Devil’s Peak and
thus horizontal multipath effects become more prevalent. Seeing that the
gain pattern measurement is based on received power, it is likely that sig-
nal power reflected from the mountain would be incident on the main lobe of
the antenna array in the case where the array axis is pointing towards the
Tygerberg transmitter. This causes the measured power to increase, which
translates to an increase of pattern gain for the particular azimuth direction
in question.

The depth of the null at point B is of satisfactory depth. The ratio of the null
to direction of aircraft en route with JHB is 24.5 dB. This level, which is 5.1
dB lower than the simulated 29.6 dB is deemed acceptable.

5.3 Predicted Coverage with Measured Target
Antenna Array Pattern

The predicted coverage in terms of radar detection range and required dy-
namic range of the receiver is shown in this section. The investigation here
follows a similar format to that of Section 4.4. In this case however the perfor-
mance prediction is done using the measured radiation pattern of the folded
dipole array.

Figure 5.7 ° shows the radar detection range in terms of SNR at an altitude
of 1600 m. For an SNR of 15 dB the PCL system has an expected range of 100
km in a North-Easterly direction. The coverage shown here is slightly less
than the coverage predicted in Figure 4.11 in the direction of aircraft en route
with JHB. There is however a slight increase in the coverage in the South-
East direction. This is as expected due to the variations in the measured gain
pattern apparent in Figure 5.6.

3See Appendix C.1.5 and Table C.1 for the complete set of configuration parameters used.
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Figure 5.7: Spatial SNR map [dB] at an altitude of 1600 m using the measured
target antenna array pattern.

The detection range at 5000 m is shown in Figure 5.8 *. Similar relation-
ships can be seen between the this figure and Figure 4.13 as were seen for the
case at 1600 m. Namely, the coverage for the case of the measured pattern is
slightly less than that using the simulated antenna radiation pattern. How-
ever, looking at Figure 5.8, the detection range is still very good at around 130
km for an SNR of 15 dB.

Finally, Figure 5.9 ° shows the predicted SIR indicating the required dynamic
range of the receiver. For an aircraft at an altitude of 1600 m and a required

dynamic range of - 60 dB, coverage of aircraft is in some cases expected to be
up to 140 km.

The coverage shown here in terms of SNR and SIR is generally quite good and
comparable to coverage achieved by existing experimental systems in the UK

[2].

5.4 Conclusion

This chapter presented the measured gain pattern of a folded dipole array
previously simulated in Chapter 4. This measured pattern was subsequently

4See Appendix C.1.6 and Table C.1 for the complete set of configuration parameters used.
5See Appendix C.1.5 and Table C.1 for the complete set of configuration parameters used.
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Figure 5.8: Spatial SNR map [dB] at an altitude of 5000 m using the measured
target antenna array pattern.
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Figure 5.9: Spatial SIR map [dB] at an altitude of 1600 m using the measured
target antenna array pattern.
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used within the performance prediction model to compare the expected cover-

age of a simulated antenna array with that of a real antenna array.

The gain pattern measured on the roof of Menzies using commercial off-the-
shelf antenna hardware seemed to be in good agreement with that simulated
within FEKO previously. Some discrepancies were noted however. The dis-
crepancies can be partially attributed to multipath effects as well as to the
insertion loss of the combiner, which were not factored into the simulation.
The combiner would cause additional attenuation, or a decrease in the mea-
sured gain pattern. In terms of multipath, the Menzies roof is positioned at
the foot of Devil’s Peak and thus horizontal multipath effects become more
prevalent.

Regardless of these effects, the ratio of the null to the peak of the main lobe
is at a satisfactory level of 24.5 dB. This result suggests that Schelkunoff’s
Unit-Circle Method is an effective technique for the purpose of null place-
ment. Furthermore, this coupled with the good agreement of the simulated
and measured patterns confirms that the application of Schelkunoff Method
in Chapter 4 yields a physically realisable pattern.

The measured pattern was finally used as the receiver pattern within the
performance prediction model. The results suggested a relatively similar de-
crease in expected coverage at an altitude of 1600 m and 5000 m in terms of
radar detection range, for an SNR of 15 dB. The decrease was slight from the
results seen in Chapter 4 and as expected due to the decrease in the main
lobe of the gain pattern. However, good coverage comparable to existing ex-
perimental systems was still predicted up to around 100 to 130 km.

In terms of SIR, a required dynamic range of around -60 dB and for aircraft at
an altitude 1600 m, coverage is expected to extend to about 140 km. This was
again seen to be slightly less than its Chapter 4 counterpart. Nevertheless,
the coverage in terms of SIR still remains quite good, due to the respectable
24.5 dB null to peak ratio.
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Chapter 6
Conclusion

The method of bistatic PCL radar performance prediction proposed in this
dissertation offers a marked improvement over conventional methods based
on the bistatic radar equation within a free space or flat terrain environment.
Furthermore, methods of improving the performance of a PCL system via

antenna pattern synthesis techniques were presented.

The improved method discussed in this dissertation offers a greater accuracy
of predicted performance by accounting for the effects of the environment on
a propagating signal. The method makes use of realistic propagation loss
data computed by the AREPS utility to provide performance predictions in
the form of spatial Signal-to-Noise Ratio and Signal-to-Interference Ratio cov-
erage maps. The coverage maps, based on the bistatic radar range equation,
provide a visual means for determining radar detection range and coverage
feasibility. These represent the probability of detection (and false alarm) of a
target and required receiver dynamic range respectively.

A comprehensive preliminary study into the properties of the available broad-
cast transmitters and their associated signals of the Western Cape was com-
pleted in order to identify one transmitter with the best characteristics for
an illuminator of opportunity. The terrain effects on the propagating signals
were also considered using AREPS. Finally, the Villiersdorp transmitter was
identified as acceptable for a PCL receiver located at the University of Cape

Town.

Following the preliminaries, the improved bistatic performance prediction
method was explained. The method involves the extraction and interpolation
of accurate propagation loss data from AREPS and the subsequent computa-
tion of the coverage maps using the interpolated data in conjunction with the
bistatic range equation. These realistic performance predictions were illus-
trated by means of a case study and developed throughout the dissertation,
where the case study makes use of real parameters of the Villiersdorp trans-

mitter and a receiver located at UCT.
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Firstly, an omnidirectional target antenna was used at the PCL receiver site.
Comparing the conventional performance prediction method, which utilises
free space loss, and the improved performance prediction utilising AREPS
propagation loss data, a vast difference in expected coverage was observed.
In terms of radar detection range, the conventional method predicted cov-
erage of up to 250 km for a target at an altitude of 1600 m, which in the
light of existing experimental passive radars is very optimistic. However, the
coverage predicted at the same altitude using realistic propagation loss was
significantly reduced, in this case only extending to about 75 km. This result
emphasises the major effect that terrain has on a propagating signal.

Furthermore, the limitation imposed on the PCL radar by the direct signal
in the target channel was observed in the spatial SIR maps. Namely, for an
omnidirectional target antenna the predicted coverage was poor and only up

to a range of 50 km for a required receiver dynamic range of -60 dB.

To improve the coverage of the PCL system the direct path interference was
suppressed in a target antenna pattern null - synthesised using the Schelkunoff
Unit-Circle method. The null to main lobe ratio was simulated in FEKO to be
29.7 dB. The physically measured pattern agreed well with the simulated, but
had a slightly lower null depth of 24.5 dB. Applying the measured pattern to
the target antenna of the PCL receiver saw a vast improvement in coverage
over the coverage expected with the omnidirectional target antenna. For the
specified receiver dynamic range (-60 dB) the improvement was in the order
of 90 km (total range of 140 km) for a target at 1600 m.

Comparing the resulting radar detection range of the synthesised target array
with that of omnidirectional antenna saw the coverage described by the spa-
tial SNR map increase to 130 km in the North-Easterly direction at the cost
of coverage in the Southern direction and in the direction of the transmitter.

While suppressing the direct signal, the synthesised pattern also causes a
decrease in radar detection range in certain sectors. However, due to its low-
cost nature multiple PCL receivers can be employed to create a netted (multi-
static) PCL radar in so doing increasing coverage of region as well as adding
redundancy, an important property for any radar system.

Finally, the work done in this dissertation showed a simple yet effective method
of producing realistic, environmentally dependent, coverage maps for a bistatic
PCL radar. Furthermore, a technique of suppressing the significant limitation
caused by the direct signal was discussed and presented. This prediction tool
can be used to characterise the performance of any bistatic PCL configuration
before final implementation.
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Chapter 7

Future Work

The topic of PCL radar offers many different avenues for future work. Some
of these avenues are currently being explored by colleagues within the Radar
Remote Sensing Group (RRSG) at the University of Cape Town.

To begin with, the work in this dissertation emphasised the importance of
factoring in environmental propagation effects in performance predictions of
radar systems. An avenue to be investigated is the incorporation of the real-
istic AREPS propagation loss data in the Flexible and Extensible signal level
Radar Simulator (FERS) ' developed by Marc Brooker [18].

Currently, performance predictions of bistatic radar configurations using the
method outlined in this work requires the use of two different platforms.
Namely, to begin with AREPS computes the realistic propagation loss after
which Matlab is used to compute the coverage predictions. This increases the
time taken to investigate any one bistatic configuration. The method can be
extended by automatically calling AREPS without the need to compute the
propagation loss manually.

The performance prediction method presented here assumed a constant bistatic
radar cross section. An avenue for future research is that of the multistatic
RCS of a target. Little is published in open literature concerning the bistatic
and more specifically the multistatic RCS of a target. Thus, research towards
a better understanding of the behaviour of the RCS of a target in a multi-
static radar configuration would be extremely beneficial to radar simulators
and performance prediction utilities, such as the FERS simulator and the
prediction method presented in this dissertation. Together with numerically
modelled multistatic radar cross section estimates, these utilities will allow
realistic investigations of multistatic PCL radar systems.

The work done here also opens up the possibility of performing receiver site
optimisation. Namely, the method presented in this dissertation could be ex-

Thttp:www.sourceforge.org/projects/fers

78



tended to find the best possible receiver site in a specific region with varying
mountainous terrain, for a given set of transmitters.

As discussed in this dissertation, the direct path signal in the target antenna
channel is a major limiting factor of any bistatic PCL system. Methods to sup-
press this direct path signal were discussed in Chapter 1 and are important
avenues to consider for future work. Some investigations are currently under-
way by members of the RRSG. For instance, adaptive filter techniques using
the USRP (Universal Software Radio Peripheral) are being investigated for
the purpose of direct path interference cancellation. Furthermore, techniques
for analog and digital beamforming for a planar array [34, 35, 36] are also
of interest and are currently being investigated as an extension of the work
done here.
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Appendix A

SRTM data to DTED conversion

This section will describe in detail how a conversion from SRTM () data for-
mat to DTED (Digital Terrain Elevation Data) data format can be achieved.
AREPS, the EM propagation tool used in this dissertation, requires terrain
data in the DTED format in order for it to calculate the propagation factor, F,
accurately.

The format referred to as DTED is mainly used by the US military. The reso-
lution and some metric approximations are given in the table below.

Table A.1: Resolution and metric approximations of DTED levels

DTED | Arc seconds Approximate
Level | in Latitude [’] | Metric Distance [m]
0 30 ca. 900
1 3 ca. 90
2 1 ca. 30

Conversion from SRTM to DTED

MICRODEM' is a freeware microcomputer mapping program written by Pro-
fessor Peter Guth of the Oceanography Department, U.S. Naval Academy. The
program MicroDEM is able to produce 1x1 degree tiles very easily by simply
going through the following steps:

Load the program MicroDEM.

Unlike VTBuilder?, another tool for viewing and processing many kinds of
geospatial data, with MicroDEM you are required to unzip the SRTM data so
that it is purely in .tif (GeoTiff) format. Click File>Open>Open DEM, then
select the GeoTiff that you would like to convert to DTED and click OK.

Thttp://www.usna.edu/Users/oceano/pguth/website/microdem.htm checked April 2009
2http://www.vterrain.org/Doc/VTBuilder/overview.html checked April 2009
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You should now see a SRTM GeoTiff tile of the area that you are interested
in. By clicking Info some information concerning the particular GeoTiff tile
should be displayed. Some important properties to note are:

DEM size: 6000x6000

Grid Space: 3x3” (about 88.44x94.23m)

This information is given for a 5x5 degree tile.

From this tile we are able to export 1x1 degree DTED tiles of Level 1 format
for the elevation data for AREPS. To get a better view of which tile you wish to
convert set the grid to 1x1 degrees under the menu path Modify > Grid; in the
dialogue box enter a 1 in the space provide next to Lat/long grid interval(®).

Now, select File>Save DEM >DTED. You will now be presented with a DTED
save parameters dialogue box. In this dialogue box all the necessary prop-
erties for conversion to DTED 1 are available. Check the Force 1°cell box.
Once checked you are able to specify the bottom left Latitude and Longitude
coordinate of the DTED tile to be created.

Also ensure that the DTED level is set to 1. This will create an elevation tile
of resolution 3x3” in DTED format. Click OK.

If these elevation tiles are to be used for AREPS you must use the following
naming convention. When prompted to save the file, create a folder with name
describing the longitudinal position of the bottom left corner such as e012,
€023 or w019 etc. (note the 3 digits), where E and W represent east or west
and the 012, 023 or 019 represents the whole degrees of longitude [27]. Now,
within this folder you must save the actual DTED file as S19.DTX or N24.DTX
where N24 and S19 represent the whole degrees of latitude. The file extension
represents the DTED level [27]. In the case of this dissertation, the extension
would be *.DT1.

Click OK when you have named the file and repeat the process for as many
times as necessary. You can save multiple .DTX files of latitude under one
folder of longitude.
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Appendix B

PPM (Performance Prediction
Method) Matlab Code Running
Procedure

The procedure to produce SNR, SIR and SNIR coverage maps is explained
here. This procedure can be divided into 3 major steps. The first involves
producing the necessary raw polar propagation loss data using AREPS.

The second step explains the procedure of capturing the propagation loss data.
In this step the data stored in the AREPS data files is extracted by a series of
Matlab scripts. An interpolation over a regular grid is also done here.

The third step involves visualisation of results. This step explains the the
available options for visualisation. Among these options are the mapping
SNR, SIR and SNIR coverage as well as the plotting of propagation loss data

over a given area.

This appendix is split into four section. Section B.1 deals with AREPS specific
tasks. Section B.2 explains the folder structure used and necessary initiali-
sations done by the PPM (Performance Prediction Method) code. Section B.3
explains the execution process of PPMcompute.m, PPM code. Finally, Section
B.4 describes the visualisation of - most importantly - the SNR, SIR and SNIR
data.

All the necessary data files can be found in the folder on the RRSG server or
on the DVD provided with this dissertation, namely:

RRSG Server /rrsg/data/software/Performance Prediction Method

CD /software/Performance Prediction Method
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B.1 Step 1 - AREPS

Here all the required steps to produce the necessary AREPS propagation
data are explained. For completeness this explanation will begin with all
the initialisation steps required after a new installation of AREPS. It is rec-
ommended that the reader go through Section B.1.1 to ensure that AREPS is
setup correctly. Thereafter, the process of executing an AREPS project will be
looked at.

B.1.1 AREPS Initialisation

Assuming you have a new installation of AREPS, some initial steps must be
taken before execution.

Check your version of AREPS via Help > About AREPS. The version of AREPS
used during the completion of this dissertation was Version 3.6.02.42 May 10,
2007 and was run on a Windows XP OS.

AREPS requires (Digital Terrain Elevation Data) DTED elevation data. This
is a specific elevation format. This terrain data can be found in the folder
\Terrain data on the RRSG server or CD the location of which is given above.
The elevation data contained in this folder covers a large sector of south west-
ern South Africa. See Appendix A for information on the DTED elevation
format and on how to create more elevation data for additional regions. It is

suggested that you copy this terrain data to your hard drive and place it in
the ..\AREPS30\Data\Dted folder.

Next, we are going to import the necessary data associated with all the trans-
mitters and receivers. This data has already been prepared and only needs to
be imported. Select Systems > Database Utilities > Open an Existing Database.
In the dialogue, browse to the folder ..\ Areps\Databases on your the DVD or
on the RRSG server and select PCL Database.

The raw propagation loss data computed by AREPS is not stored by default
and needs to be enabled. To store this data for further computations within
Matlab (Section B.3) select Options > Save Optional Data. This opens the
AREPS Configuration - Save Optional Data Options window. Check the APM
data in ASCII text format and the Terrain data in ASCII text format tick box.
The coverage display tick boxes can remain unchecked. Check the tick box
that indicates that previously saved optional files for a particular project will

be removed before a new execution.

Next, select Options > Program Flow. This opens the AREPS Configuration
- Program Flow Options window. In this window change the default earth

quadrant to Southeast and the initialisation units to Metric.
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Now, select Options > Terrain Data. This opens the AREPS Configuration -
NGA (DTED /| SRTM) Terrain Options window. Change the DTED level to the
available DTED elevation data level; in the case of this report level 1 was
used. Check the Assume empty fields are water tick box. Also, enter zero
latitude and longitude to bypass file editor defaults.

Finally, select Options > Default Project > APM Parameters. In the AREPS
Configuration - APM Parameters Options window, select the options Use pa-
rameters for all projects and Full coverage mode. Everything else can be left
as default.

B.1.2 AREPS Execution

You are now ready to run AREPS and create an AREPS Project.

Select File > New. .. > Standard Project. This will open an Untitled AREPS
Project window. After specifying all the necessary information in this window
you will be able to run AREPS and create an AREPS Project. Various details
in this window can be checked and changed (should not be necessary) by right-
clicking on the option name.

In the Decision Aid box select the Communications (> 30 MHz) radio button.

In the Environment Specification box select <Use DTED> from the Terrain
drop-down menu. If you would like to perform your investigation a flat earth
you can select <None> instead.

The Graphic Display box can be used to specify your area of interest by enter-
ing the minimum and maximum height and maximum range of your investi-
gation. As an example, specify a height range of 0 to 6000 m above mean sea

level and a maximum radial range up to 200 km.

In the System Specification box select the site for your investigation from the
Platform/Site drop-down. For example, select Constantiaberg C1. Check that
the Auto-populate box next to the Platform/Site drop-down is ticked. This will
ensure that the geological latitude and longitude co-ordinates are automati-
cally entered into the Project Geographic Area box below. All other tick-boxes

in the Systems Specification box should remain unticked.

Now, choose an emitter from the Transmitter drop-down. All the possible
emitters located at this site are listed in this drop-down menu. In the case
where Constantiaberg C1 is the project site, only two emitters are available.
To continue with the example, select the const Rad5 89 as the emitter. This
will have caused the Antenna height (m) AGL box to be updated with the
height of the antenna of the const Rad5 89 emitter. Ensure that the antenna
height is given as height above ground level (AGL) and not height above mean

sea level (MSL). As mentioned above, right-click on any value or unit in the
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AREPS Project window to make any changes.

The choice of Comm receiver is not important for the purposes of this inves-
tigation. This is because, in terms of AREPS, we are only interested in the
propagation loss from a Platform/Site by a Transmitter for a specific area of
interest. Any platform can be chosen here.

Finally, the Project Geographic Area box must be populated. The Latitude
and Longitude (Deg) should have been auto-populated and should show the
position of the Platform/Site chosen above.

Upon execution, AREPS computes the propagation loss along a specified bear-
ing. Additional computations are done by incrementing the bearing, namely
by moving the bearing of interest in a clockwise direction. Thus, an area of
interest can be described by specifying the First bearing (°T'rue) , the Bearing
increment (Deg) and the Number of bearings.

Currently, the Matlab script is only capable of dealing with bearings divisible
by 5. This means that the First bearing must be divisible by 5 and that the
Bearing increment must be 5°.

The subsequent Number of bearings must be chosen to encompass the area
of interest. For example, the Constantiaberg transmitter has a beamwidth
of half-power beamwidth of 70° centred at 25°. This translates to an area of
interest described by the bearing range 350° to 60° at 5° steps. Subsequently,
the first bearing will be 350°, the bearing increment 5° and the number of
bearings 15.

For the common case of an omnidirectional transmitter, the first bearing will

be 0°, the bearing increment 5° and the number of bearings 72.

B.1.3 AREPS Data Format

Propagation loss data for each bearing is saved within one text file. There
are two sections of interest in each text file. One section for the propagation
loss data and another for the propagation factor. Subtracting the propagation
factor from the propagation loss data provides one with free space propagation
loss data, in essence giving one all the necessary propagation loss data.

The propagation data for both sections is further divided into loss data at
finite heights. For each of these heights there is a set of finite range points.
An example of data format can be seen by viewing the text files within a
project folder .
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B.2 PPMRoot (Performance Prediction Root)

Folder Structure and Initialisations

The Matlab scripts necessary to create the coverage maps are contained in
a directory named PPMRoot<yymmdd>, <yymmdd> corresponds to the latest
updated version, for example PPMRo00t090104. This directory will be referred
to as the root directory. The directory and its sub-folders is shown in Figure
B.1.

=l ) MATLAB

4 ) PPMRaocok030103

= |2 PPMRoot090104
] fnktenna Patkerns
] Comman Sub Funckions
) Configuration Information
) Main Funckions
() Map Information
] Resulks

Figure B.1: Folder structure of the PPMRoot folder.

B.2.1 Configuration Information Folder

Some parameters need to be initialised before executing the PPMcompute
script. The most important of these is the initialisation text file found in the
folder Configuration Information. This file contains all the initialisation data
necessary for PPM scripts to run correctly. The type of output data required
is also set in this text file. The parameters contained in an initialisation text
file are shown in B.1. As an example here, the parameters for a transmitter
of opportunity at Constantiaberg and a receiver at UCT Menzies are given.

Transmitter Information

1 Transmitter Name This is the name given to the transmitter to identify
in very general terms.

2 Tx Latitude [d°,m/, s”, Hemi] This is the geographical latitude of the trans-
mitter. It must written in a CSV format as indicated in the square brack-
ets. The degrees, minutes and seconds are measured from the equator
0°,0,0” to any one of the north or south poles 90°,0’,0”. The variable
Hemi signifies the hemisphere of d, m, s value and can either be N or §
(north and south respectively).
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Table B.1: Initialisation Parameters for PPMcompute.m

Transmitter Information

1 Tx Name Constantiaberg

2 Tx Longitude [d°, m/, s”, Hemi] 34,3,15,S

3 Tx Latitude [d°, m’, s”, Hemi] 18,23,15.E

4 AREPS Tx Project Folder Name ConstantiabergTx89

5 Frequency [MHz] 89

6 Power [W] 1000

7 Tx Beamwidth Start [0° — 359°] 350

8 Tx Beamwidth End [0° — 359°] 60

9 Gain Within Beamwidth [dB] 10

10 Gain Outside Beamwidth [dB] -30

Receiver Information

1 Rx Name Menzies

2 Rx Longitude [d°, m’, s”, Hemi] 33,57,31.16,S

3 Rx Latitude [d°, m/, s”, Hemi] 18,27,36.36,E

4 AREPS Rx Project Folder Name MenziesRx89

5 Antenna Pattern [*.mat file] AntPat.mat

6 Rx Sector Start [0° — 359°] 350

7 Rx Sector End [0° — 359°] 60

8 Receiver Noise Figure, F), [dB] 10
Additional Information

1 PL Data Calculation Choice [y/n] n

2 Free Space PL Calculation [y/n] y

3 Altitude [m] 1600

4 || SNR and SNIR Processing Bandwidth, B [Hz] 1

5 Target RCS [m?] 10

6 Antenna Noise Temperature T, [K] 290
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3 Tx Longitude [d°,m/, s", Hemi] This is the geographical longitude of the
transmitter. It must written in a CSV format as indicated in the square
brackets. The degrees, minutes and seconds are measured from the
meridian 0°,0’,0” to the international date line at 180°,0/,0” in an east-
erly or westerly direction. The variable Hem: signifies the hemisphere
of d, m, s value and can either be E or W (East and West respectively).

4 AREPS Tx Project Folder Name This is a string of characters that makes
up the name of the folder that contains all the AREPS generated prop-
agation loss data relevant to one transmitter (at the specified location).
The words and numbers that make up this string of characters are usu-
ally chosen in such a way that they completely describe the project. An
example here as shown in Table B.1, is ConstantiabergTx95.3, where the
chosen characters imply that the transmitter used is at Constantiaberg
and that the frequency used is 95.3 MHz.

5 Frequency [MHz| This is the FM radio frequency used for the investiga-
tion. It is given in MHz.

6 Power [W] This is the TPO (Transmitter Power Output). This is the amount
of power used to emit the FM radio signal at the specified frequency.

7 Tx Beamwidth Start [0° — 359°] This contains the value for the start of
the HPBW (Half Power Beamwidth) for the transmitter pattern as given
by the specifications by Sentech.

8 Tx Beamwidth End [0° — 359°] This contains the value for the end of the
HPBW (Half Power Beamwidth) for the transmitter pattern as given by
the specifications by Sentech. The transmitter beamwidth is measured
clockwise from 7 Tx Beamwidth Start to 8 Tx Beamwidth End.

9 Gain Within Beamwidth [dB] This is the gain within the HPBW of the

transmitting antenna radiation pattern.

10 Gain Outside Beamwidth [dB] This is the gain outside the HPBW of
the transmitting antenna radiation pattern.

Receiver Information

1 Receiver Name This is the name given to the receiver to identify it in

general terms.

2 Rx Latitude [d°,m/, s”] This is the geographical latitude of the receiver.
See 2 Tx Latitude for a description of variable format.
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3 Rx Longitude [d°,m/, s"] This is the geographical longitude of the receiver.
See 3 Tx Longitude for a description of variable format.

4 AREPS Rx Project Folder Name This is a string of characters that makes
up the name of the folder that contains all the AREPS generated propa-

gation loss data relevant to one receiver (at the specified location). See
4 AREPS Tx Project Folder Name for more detail.

5 Antenna Pattern [data file] The data file referenced here will contain in-
formation on the antenna radiation pattern of the receiver. This allows
for receiver antenna patterns, simulated in modelling software such as
FEKO, to be included in the bistatic coverage prediction. The data file
must be in a *.mat (Matlab data file) format.

6 Rx Sector Start [0° — 359°] This contains the azimuth value that describes
the start of the sector of interest as seen from the receiver.

7 Rx Sector End [0° — 359°] This contains the azimuth value that describes
the end of the sector of interest as seen from the receiver. The sector of
interest is measured clockwise from 6 Rx Sector Start to 7 Rx Sector
End. The sector of interest is an important consideration. For the proper
visualisation of the coverage results one must ensure that at least some

of the transmitter beamwidth is covered by the sector of interest.

8 Receiver Noise Figure F, [dB] The receiver noise figure specifies the noise

added within the receiving system.

Additional Information

1 PL Data Calculation [y/n| This allows the option of calculating the prop-
agation loss (PL) data from the transmitter and receiver without taking
into account the gain patterns of either the transmitter or the receiver.
Processing time is saved by choosing not to (specify n) calculate the prop-
agation loss and gain-free data.

2 Free Space PL Calculation [y/n] This allows the option of calculating free
space losses in addition to the usual AREPS terrain propagation losses.
Processing time is saved by choosing not to (specify n) calculate free

space losses.

3 Altitude [m| The altitude at which the investigation is performed. All the
resulting data will be given for that altitude.

4 SNR Processing Bandwidth B [Hz| The processing bandwidth is linked
with the integration time. Namely, by 7, = 1/B,.
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5 Target RCS [m? This is the target’s bistatic Radar Cross Section (RCS).

6 Antenna Noise Temperature 7, [K] This is the noise temperature of the
antenna and is usually kept at room temperature.

B.2.2 Antenna Patterns Folder

This folder contains any receiver/target antenna patterns that you would
like to use within your performance prediction. These antenna patterns are
saved as *.mat files. As an example, the antenna pattern specified in Table
B.1 is AntPat.mat. This Matlab data file contains two variable; PhiAnt and
GainAnt. The two variables must be named PhiAnt and GainAnt.

PhiAnt corresponds to the azimuth angle, ¢, measured clockwise from True
North. ¢ must be defined for the range [0°, 359°] and must have corresponding
gain (GainAnt) values for every ¢ point.

B.2.3 Map Information Folder

This folder contains three images of the Western Cape terrain, which are used
as background for the spatial mapping of SNR, SIR and SNIR. The projection
of these terrain images is UTM with the dimensions of the maps precisely
known. Being UTM allows Cartesian data to be overlayed.

B.2.4 Main Functions Folder

This folder contains the main functions, which are stand-alone functions.
They are not called by any other functions and are written to perform spe-
cific tasks. The functions contained in this folder are:

e BearingCalc.m

e TxRxAirportPos.m

PPMcompute.m

PPMplotter.m

SNRdata.m

The two functions important to the this section are PPMcompute and PPM-
plotter. These two functions compute the SNR, SIR and SNIR coverage data
and allow visualisation of the data by overlaying onto a Western Cape map re-
spectively. To achieve this they call the Common Subfunctions (Section B.2.5).
More in-depth descriptions of these functions can be obtained by typing help
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function_name (example help PPMcompute) at the command line within Mat-
lab, after path initialisation (Section B.2.7).

B.2.5 Common Subfunctions Folder
e BearingPadding.m
e DisplayInfo.m
e dmsh2deg.m
e FindPos.m
e geoZutm
e ImportMap.m
e RxTxPostion.m
e SampleGain.m
e SIRcalc.m
e SNIRcalc.m
e SNRcalc.m
e TheoFSPLcalc.m

e TxPat.m

More in-depth descriptions of these functions can be obtained by typing help
function_name (example help SNRcalc) at the command line within Matlab,
after path initialisation (Section B.2.7).

B.2.6 Results Folder

The Results folder would contain all the data computed by PPMcompute. In
general, it will contain three different sets of propagation loss data; one asso-
ciated with the receiver, one with the transmitter and one containing all the
combined propagation loss data from both the transmitter and receiver.

One additional temporary data set will be saved as well, called temp.mat.
This serves as a backup of sorts and contains the same data as the combined
propagation loss data set.

All of the data files will be Matlab *.mat files. The data filenames, with refer-
ence to Section B.2.1, will be in the following format:
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1. Receiver specific data:
<Areps Rx Project Folder Name>_<Altitude>.mat. An example is Men-
ziesRx96.5 1600.mat

2. Transmitter specific data:
<Areps Tx Project Folder Name>_<Altitude>.mat. An example is Vil-
liersdorpTx96.5_1600.mat.

3. Combined specific data:
<Areps Tx Project Folder Name>_<Areps Rx Project Folder Name>
_<Altitude>.mat.
An example of this is VilliersdorpTx96.5_MenziesRx96.5_1600.mat.

The variables (data) contained in each of these *.mat files will depend on the
specifications made in the Configuration Information (Section B.2.1).

When running PPMplotter.m you will prompted to select one (or more) of
these data sets. The prompt will specify whether receiver, transmitter or com-
bined specific data is required.

B.2.7 Path Initialisations

The paths to all the necessary functions, subfunction, maps, results and an-
tenna patterns must be initialised before the execution of any of the main
functions. This is done by running the IniPaths.m script found in the RootPPM
directory. Running IniPaths.m will set the RootPPM directory in which it is
found as the current working directory of Matlab.

Once the paths have been initialised PPMcompute.m and PPMplotter.m (pro-
vided available Results data in the case of PPMplotter.m) can be run by simply
typing the script name in the Command Window.

B.3 Step 2 - Matlab PPMcompute script

This step will explain the execution process of PPMcompute.m. The name
stands for the computation of the data necessary for performance prediction
method. This Matlab script imports data generated by AREPS and extracts
all the information necessary for the specified investigation. As emphasised
in the dissertation, AREPS data contains the effects of the environment.

B.3.1 Execution of PPMcompute.m

Before the execution of the PPMcompute.m script the paths need to be ini-
tialised. This is done by the IniPaths.m found within the root directory (Sec-
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tion B.2.7).

After typing PPMcompute in the Command Window, you will be prompted to
select a configuration information text file. This text file will serve as input to
the PPMcompute function. Thus it is important to ensure that the parameters
are specified correctly within the configuration file.

Once the configuration file is selected, the parameters are printed out within
the Command Window again for confirmation purposes.

You will be required to press return at this point to proceed. Once return is
pressed, the script begins to extract the specified propagation loss data from
the entire data set previously computed by AREPS (Section B.1).

In simple terms, the PPMcompute script searches for a particular altitude
within a text file associated with a certain bearing. Once the required alti-
tude is found, the associated propagation data over the finite range steps is
extracted. The range steps and consequently the propagation data (along a

particular bearing) are mapped to a Cartesian UTM grid for a certain altitude.

Continuing this process, results in a number of polar propagation data sets.
This polar data is then interpolated of a regular Cartesian UTM grid.

A host of useful information is captured from the AREPS propagation data.
For this reason, the data is saved to the hard drive, which also aids in freeing
up memory. The results from PPMcompute are saved in the Results folder
(see Section B.2.6 for more details about the saved data).

B.4 Step 3 - PPMplotter Script

This is the final step, and it involves the creation and visualisation of - most
importantly - the SNR, SIR and SNIR data. Other data can also visualised,
such as the propagation loss data from the transmitter and receiver sites.
There are four main options available when running the PPMplotter.m script;
these are:

1. Plot propagation loss data
2. Plot a SNR coverage map
3. Plot a SIR coverage map

4. Plot a SNIR coverage map

The flow of these options is illustrated in Figure B.2. Option 1 (Plot Propaga-
tion Loss (PL)) branches to the top of the figure and options 2 through 4 (Plot
SNR /SIR/SNIR Coverage) branch to the bottom.
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Figure B.2: Illustration of possible options within PPMplotter.m.
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The processes indicated with a yellow block, require extra data computed by
specifying ’y’ for the PL Data Calculation parameter detailed in Section B.2.1.
The processes indicated with the green blocks, require extra data computed
by specifying ’y’ for the Free-Space Data Calculation parameter detailed in
the same section.

All the processes indicated by the blue blocks can be performed under default
conditions.
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Appendix C

Dissertation-Specific
Configuration Information

The configuration information detailed here relates to a bistatic PCL system
which utilises the Villiersdorp transmitter as the illuminator of opportunity
with the receiver located on the roof of the Menzies building at UCT. Investi-
gations done in this dissertation were performed at different altitudes, with

different antenna patterns, but in general shared many common parameter.

First the exceptions to the common parameters listed in Table C.1 are given.
Thereafter, a section is dedicated to each configuration used in this disserta-
tion. Namely, each following section contains information on data used for the
exception for the investigation performed.

C.1 Exceptions

All the configurations used within this dissertation for illustration purposes
use the configuration information shown in Table C.1 with two exceptions.
These two exceptions are:

e The target antenna pattern (Number 5 of the Receiver Information sec-
tion).

e The altitude of interest (Number 3 of the Additional Information sec-
tion).
C.1.1 Configuration Information Set A

Antenna Pattern [data file] An omnidirectional target antenna receiver pat-

tern called, Omni5dB.mat, was used here.

Altitude || The altitude of interest is 1600 m above sea level.
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Remaining Parameters These are common to all configurations used in
this dissertation and are listed in Table C.1.

C.1.2 Configuration Information Set B

Antenna Pattern [data file] An omnidirectional target antenna receiver pat-

tern called, Omni5dB.mat, was used here.
Altitude || The altitude of interest is 5000 m above sea level.

Remaining Parameters These are common to all configurations used in
this dissertation and are listed in Table C.1.

C.1.3 Configuration Information Set C

Antenna Pattern [data file] An antenna array of folded dipoles was used
here in order to suppress the DPI from the illuminating transmitter.
This pattern was simulated with FEKO. The antenna pattern is saved
in the Matlab data file named, 4eleFDArray.mat.

Altitude [m] The altitude of interest is 1600 m above sea level.

Remaining Parameters These are common to all configurations used in
this dissertation and are listed in Table C.1.

C.14 Configuration Information Set D

Antenna Pattern [data file] An antenna array of folded dipoles was used
here in order to suppress the DPI from the illuminating transmitter.
This pattern was simulated with FEKO. The antenna pattern is saved
in the Matlab data file named, 4eleFDArray.mat.

Altitude || The altitude of interest is 5000 m above sea level.

Remaining Parameters These are common to all configurations used in
this dissertation and are listed in Table C.1.

C.1.5 Configuration Information Set E

Antenna Pattern [data file] An antenna array of folded dipoles was used
here in order to suppress the DPI from the illuminating transmitter.
This antenna pattern was the pattern measured on the roof of Menzies.
The antenna pattern is saved in the Matlab data file named, 4FDSchelk-
MeasPat.mat.

97



Altitude || The altitude of interest is 1600 m above sea level.

Remaining Parameters These are common to all configurations used in

this dissertation and are listed in Table C.1.

C.1.6 Configuration Information Set F

Antenna Pattern [data file] An antenna array of folded dipoles was used
here in order to suppress the DPI from the illuminating transmitter.
This antenna pattern was the pattern measured on the roof of Menzies.
The antenna pattern is saved in the Matlab data file named, 4FDSchelk-
MeasPat.mat.

Altitude || The altitude of interest is 5000 m above sea level.

Remaining Parameters These are common to all configurations used in

this dissertation and are listed in Table C.1.
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Table C.1: Common Configuration Parameters for PPMcompute.m for the
Villiersdorp-Menzies case

|

Transmitter Information

|

1 Tx Name Villiersdorp

2 Tx Longitude [d°, m/, s”, Hemi] 33,58,9,S

3 Tx Latitude [d°, m/, s”, Hemi] 19,30,25.E

4 AREPS Tx Project Folder Name VilliersdorpTx96.5

5 Frequency [MHZz] 96.5

6 Power [W] 1000

7 Tx Beamwidth Start [0° — 359°] 0

8 Tx Beamwidth End [0° — 359°] 359

9 Gain Within Beamwidth [dB] 10

10 Gain Outside Beamwidth [dB] -30

Receiver Information

1 Rx Name Menzies

2 Rx Longitude [d°, m/, s”, Hemil 33,57,31.16,S

3 Rx Latitude [d°, m/, s”, Hemi] 18,27,36.36,E

4 AREPS Rx Project Folder Name MenziesRx96.5

5 Antenna Pattern [*.mat file] See Exceptions (Section C.1)

6 Rx Sector Start [0° — 359°] 0

7 Rx Sector End [0° — 359°] 359

8 Receiver Noise Figure, I, [dB] 20
Additional Information

1 PL Data Calculation Choice [y/n] y

2 Free Space PL Calculation [y/n] y

3 Altitude [m] See Exceptions (Section C.1)

4 || SNR and SNIR Processing Bandwidth, B [Hz] 1

5 Target RCS [m?] 10

6 Antenna Noise Temperature T, [K] 290
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Appendix D

Receiver Components

D.1 Antenna

Four folded dipole antenna elements were purchased from SpaceTV. One ele-
ment can be seen in Figure D.1.

Figure D.1: Single folded dipole element.
D.2 Transmission Line and Connectors

The transmission line used was Ellies RG 6 dual shield white coaxial cable
(Series 6). Further technical features of this cable can be seen in Table D.1.
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Table D.1: Technical features.

Product Code ACRG6
Inner Conductor 1.02 mm C.C.S.
Dielectric 4.70 mm Physical Foam PE
Foil ALu/Pet
Braid 32/0.12 mm ALu
Jacket 6.80 mm PVC
Impedance 75 Q

D.3 Attenuator

Tee attenuators were built for channel 1 and 4 of the target array. The
schematic with resistors is shown in Figure D.2. The attenuator was designed
to have a nominal impedance of 75 (2 and the resistor values were found to be
R = Ry = 36.592 and R3 = 59 () using Pozar [26].

R1 R2

Port 1 R3 Port 2

Figure D.2: Tee attenuator schematic and resistors.

bbb

¥
ARHRRRELEL T b N by

Figure D.3: Tee Attenuator.

D.4 Combiner

The combiner was sourced for Ellies. Technical details were not provided
and subsequently the combiner was characterised following the measurement
procedure detailed by Pozar [26] and a Mini-Circuits application note [37].
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Figure D.4: Ellies splitter/combiner.

Table D.2: Combiner characteristics at 96.5 MHz

Frequency Insertion Loss [dB]|
[MHz| S-1|8S2]|8S3]S4
90 7.02|7.08 | 7.04|7.04
95 7.03 | 7.09 | 7.06 | 7.04
100 7.05|7.11 | 7.08 | 7.06
105 708 (7.13|711| 7.1

(a) Insertion Loss

Frequency Isolation [dB]

[MHz] 1-2 | 13 | 14 | 23 | 24 | 34
90 25.83 | 27.98 | 28.3 | 28.13 | 28.6 | 25.63
95 25.86 | 28.03 | 28.34 | 28.2 | 28.6 | 25.7
100 25.95 | 27.96 | 28.41 | 28.23 | 28.7 | 25.78
105 25.96 | 27.98 | 28.39 | 28.21 | 28.68 | 25.88

(b) Isolation

-145 T T T | T |

-150 B

-155 4

-165 J

-170 J

175 i i i i i I i i i

[0 a5 100 105 Q0 a5 100 105 Q0 95

Frequency [MHz]

Figure D.5: Combiner Phase Shift
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